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Important Information

Warranty

The SCXI-1540 is warranted against defects in materials and workmanship for a period of one year from the date of shipment, as evidenced
by receipts or other documentation. National Instruments will, at its option, repair or replace equipment that proves to be defective during the
warranty period. This warranty includes parts and labor.

The media on which you receive National Instruments software are warranted not to fail to execute programming instructions, due to defects in
materials and workmanship, for a period of 90 days from date of shipment, as evidenced by receipts or other documentation. National Instruments
will, at its option, repair or replace software media that do not execute programming instructions if National Instruments receives notice of such defects
during the warranty period. National Instruments does not warrant that the operation of the software shall be uninterrupted or error free.

A Return Material Authorization (RMA) number must be obtained from the factory and clearly marked on the outside of the package before any
equipment will be accepted for warranty work. National Instruments will pay the shipping costs of returning to the owner parts which are covered by
warranty.

National Instruments believes that the information in this document is accurate. The document has been carefully reviewed for technical accuracy. In
the event that technical or typographical errors exist, National Instruments reserves the right to make changes to subsequent editions of this document
without prior notice to holders of this edition. The reader should consult National Instruments if errors are suspected. In no event shall National
Instruments be liable for any damages arising out of or related to this document or the information contained in it.

EXCEPT AS SPECIFIED HEREIN, NATIONAL INSTRUMENTS MAKES NO WARRANTIES, EXPRESS OR IMPLIED, AND SPECIFICALLY DISCLAIMS ANY WARRANTY OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. CUSTOMER’S RIGHT TO RECOVER DAMAGES CAUSED BY FAULT OR NEGLIGENCE ON THE PART OF NATIONAL
INSTRUMENTS SHALL BE LIMITED TO THE AMOUNT THERETOFORE PAID BY THE CUSTOMER. NATIONAL INSTRUMENTS WILL NOT BE LIABLE FOR DAMAGES RESULTING FROM
LOSS OF DATA, PROFITS, USE OF PRODUCTS, OR INCIDENTAL OR CONSEQUENTIAL DAMAGES, EVEN IF ADVISED OF THE POSSIBILITY THEREOF. This limitation of the
liability of National Instruments will apply regardless of the form of action, whether in contract or tort, including negligence. Any action against
National Instruments must be brought within one year after the cause of action accrues. National Instruments shall not be liable for any delay in
performance due to causes beyond its reasonable control. The warranty provided herein does not cover damages, defects, malfunctions, or service
failures caused by owner’s failure to follow the National Instruments installation, operation, or maintenance instructions; owner’s modification of the
product; owner’s abuse, misuse, or negligent acts; and power failure or surges, fire, flood, accident, actions of third parties, or other events outside
reasonable control.

Copyright

Under the copyright laws, this publication may not be reproduced or transmitted in any form, electronic or mechanical, including photocopying,
recording, storing in an information retrieval system, or translating, in whole or in part, without the prior written consent of National
Instruments Corporation.

National Instruments respects the intellectual property of others, and we ask our users to do the same. NI software is protected by copyright and other
intellectual property laws. Where NI software may be used to reproduce software or other materials belonging to others, you may use NI software only
to reproduce materials that you may reproduce in accordance with the terms of any applicable license or other legal restriction.

End-User License Agreements and Third-Party Legal Notices
You can find end-user license agreements (EULAs) and third-party legal notices in the following locations:

* Notices are located in the <National Instruments>\_Legal Information and <National Instruments> directories.
¢ EULAs are located in the <National Instruments>\Shared\MDF\Legal\license directory.

¢ Review <National Instruments>\_Legal Information.txt for more information on including legal information in installers built with
NI products.

Trademarks
CVI, LabVIEW, National Instruments, NI, ni.com, the National Instruments corporate logo, and the Eagle logo are trademarks of National
Instruments Corporation. Refer to the Trademark Information at ni . com/trademarks for other National Instruments trademarks.

The mark LabWindows is used under a license from Microsoft Corporation. Windows is a registered trademark of Microsoft Corporation in the United
States and other countries. Other product and company names mentioned herein are trademarks or trade names of their respective companies.

Patents
For patents covering National Instruments products/technology, refer to the appropriate location: Help»Patents in your software,
the patents. txt file on your media, or the National Instruments Patent Notice at ni .com/patents.

Export Compliance Information
Refer to the Export Compliance Information at ni . com/legal/export-compliance for the National Instruments global trade compliance
policy and how to obtain relevant HTS codes, ECCNs, and other import/export data.

WARNING REGARDING USE OF NATIONAL INSTRUMENTS PRODUCTS

(1) NATIONAL INSTRUMENTS PRODUCTS ARE NOT DESIGNED WITH COMPONENTS AND TESTING FOR A LEVEL OF
RELIABILITY SUITABLE FOR USE IN OR IN CONNECTION WITH SURGICAL IMPLANTS OR AS CRITICAL COMPONENTS IN
ANY LIFE SUPPORT SYSTEMS WHOSE FAILURE TO PERFORM CAN REASONABLY BE EXPECTED TO CAUSE SIGNIFICANT
INJURY TO A HUMAN.

(2) IN ANY APPLICATION, INCLUDING THE ABOVE, RELIABILITY OF OPERATION OF THE SOFTWARE PRODUCTS CAN BE
IMPAIRED BY ADVERSE FACTORS, INCLUDING BUT NOT LIMITED TO FLUCTUATIONS IN ELECTRICAL POWER SUPPLY,
COMPUTER HARDWARE MALFUNCTIONS, COMPUTER OPERATING SYSTEM SOFTWARE FITNESS, FITNESS OF COMPILERS
AND DEVELOPMENT SOFTWARE USED TO DEVELOP AN APPLICATION, INSTALLATION ERRORS, SOFTWARE AND HARDWARE
COMPATIBILITY PROBLEMS, MALFUNCTIONS OR FAILURES OF ELECTRONIC MONITORING OR CONTROL DEVICES,
TRANSIENT FAILURES OF ELECTRONIC SYSTEMS (HARDWARE AND/OR SOFTWARE), UNANTICIPATED USES OR MISUSES, OR
ERRORS ON THE PART OF THE USER OR APPLICATIONS DESIGNER (ADVERSE FACTORS SUCH AS THESE ARE HEREAFTER
COLLECTIVELY TERMED “SYSTEM FAILURES”). ANY APPLICATION WHERE A SYSTEM FAILURE WOULD CREATE A RISK OF
HARM TO PROPERTY OR PERSONS (INCLUDING THE RISK OF BODILY INJURY AND DEATH) SHOULD NOT BE RELIANT SOLELY
UPON ONE FORM OF ELECTRONIC SYSTEM DUE TO THE RISK OF SYSTEM FAILURE. TO AVOID DAMAGE, INJURY, OR DEATH,
THE USER OR APPLICATION DESIGNER MUST TAKE REASONABLY PRUDENT STEPS TO PROTECT AGAINST SYSTEM FAILURES,



INCLUDING BUT NOT LIMITED TO BACK-UP OR SHUT DOWN MECHANISMS. BECAUSE EACH END-USER SYSTEM IS
CUSTOMIZED AND DIFFERS FROM NATIONAL INSTRUMENTS' TESTING PLATFORMS AND BECAUSE A USER OR APPLICATION
DESIGNER MAY USE NATIONAL INSTRUMENTS PRODUCTS IN COMBINATION WITH OTHER PRODUCTS IN A MANNER NOT
EVALUATED OR CONTEMPLATED BY NATIONAL INSTRUMENTS, THE USER OR APPLICATION DESIGNER IS ULTIMATELY
RESPONSIBLE FOR VERIFYING AND VALIDATING THE SUITABILITY OF NATIONAL INSTRUMENTS PRODUCTS WHENEVER
NATIONAL INSTRUMENTS PRODUCTS ARE INCORPORATED IN A SYSTEM OR APPLICATION, INCLUDING, WITHOUT
LIMITATION, THE APPROPRIATE DESIGN, PROCESS AND SAFETY LEVEL OF SUCH SYSTEM OR APPLICATION.



Conventions

»

> &

> >

bold

italic

monospace

monospace bold

The following conventions are used in this manual:

Angle brackets that contain numbers separated by an ellipsis represent a
range of values associated with a bit or signal name—for example,
DIO<3..0>.

The » symbol leads you through nested menu items and dialog box options
to a final action. The sequence Options»Settings»General directs you to
pull down the Options menu, select the Settings item, and select General
from the last dialog box.

This icon denotes a note, which alerts you to important information.

This icon denotes a caution, which advises you of precautions to take to
avoid injury, data loss, or a system crash. When this symbol is marked on a
product, refer to the Read Me First: Safety and Electromagnetic
Compatibility document for information about precautions to take.

When this symbol is marked on a product, it denotes a warning advising
you to take precautions to avoid electrical shock.

When this symbol is marked on a product, it denotes a component that may
be hot. Touching this component may result in bodily injury.

Bold text denotes items that you must select or click in the software, such
as menu items and dialog box options. Bold text also denotes parameter
names.

Italic text denotes variables, emphasis, a cross-reference, or an introduction
to a key concept. Italic text also denotes text that is a placeholder for a word
or value that you must supply.

Text in this font denotes text or characters that you should enter from the
keyboard, sections of code, programming examples, and syntax examples.
This font is also used for the proper names of disk drives, paths, directories,
programs, subprograms, subroutines, device names, functions, operations,
variables, filenames, and extensions.

Bold text in this font denotes the messages and responses that the computer
automatically prints to the screen. This font also emphasizes lines of code
that are different from the other examples.
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About the SCXI-1540

This chapter introduces the SCXI-1540 module, and explains how to install
the software and hardware.

@ Note Descriptions in this chapter explicitly refer to the first channel (channel 0), but these
descriptions also are applicable to the remaining seven channels.

This section provides an introduction to the SCXI-1540 module, and
to linear variable differential transformers (LVDTsS), rotary variable
differential transformers (RVDTSs), and resolvers.

The SCXI-1540 module is an eight-channel module for interfacing with
industry-standard LVDTs, RVDTs, and resolvers. It can accommodate a
4-wire or 5-wire connection to an LVDT, and can synchronize any number
of channels to a common frequency. You can set the excitation level at

1 Vsor3 V. atafrequency of 2.5 kHz, 3.3 kHz, 5 kHz, or 10 kHz. You
can set the gain over the range 0.8 to 25 to handle a wide range of LVDT
sensitivities. Gain, level, frequency, and wire mode are set on a per-channel
basis without the use of jumpers. The SCXI-1540 is configured using
Measurement & Automation Explorer (MAX) or through function calls to
NI-DAQ.

What You Need to Get Started

© National Instruments

To set up and use the SCXI-1540, you need the following:

U Hardware
—  SCXI-1540 module

—  One of the following terminal blocks:

* SCXI-1315
 SCXI-1310
« TBX-96

—  SCXI chassis or PXI/SCXI combination chassis

1-1 SCXI-1540 User Manual



Chapter 1 About the SCXI-1540

—  One of the following:
e E/M Series DAQ device
e SCXI-1600 module

—  Computer, if using an SCXI chassis

— Cabling, cable adapter, and sensors as required for your
application

Software

— NI-DAQ 7.0 or later

—  One of the following software packages:
* LabVIEW
*  Measurement Studio
e LabWindows"™/CVI™

Documentation

—  Read Me First: Safety and Electromagnetic Compatibility

— DAQ Getting Started guides

—  SCXI Quick Start Guide

—  SCXI-1540 User Manual

—  Documentation for your hardware

—  Documentation for your software

National Instruments Documentation

SCXI-1540 User Manual

The SCXI-1540 User Manual is one piece of the documentation set for data

acquisition (DAQ) systems. You could have any of several types of

manuals depending on the hardware and software in the system. Use the
manuals you have as follows:

SCXI chassis or PXI/SCXI combination chassis manual—Read this
manual for maintenance information on the chassis and for installation

instructions.

The DAQ Getting Started guides—This document has information on

installing NI-DAQ and the E/M Series DAQ device. Install these

before you install the SCXI module.

1-2
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Chapter 1 About the SCXI-1540

*  The SCXI Quick Start Guide—This document contains a quick
overview for setting up an SCXI chassis, installing SCXI modules and
terminal blocks, and attaching sensors. It also describes setting up the
SCXIT system in MAX.

*  The SCXI hardware user manuals—Read these manuals next
for detailed information about signal connections and module
configuration. They also explain, in greater detail, how the module
works and contain application hints.

*  Accessory installation guides or manuals—Read the terminal block
and cable assembly installation guides. They explain how to physically
connect the relevant pieces of the system. Consult these guides when
you are making the connections.

*  The E/M Series DAQ device documentation—This documentation has
detailed information about the E/M Series DAQ device that plugs into
or is connected to the computer. Use this documentation for hardware
installation and configuration instructions, specification information
about the E/M Series DAQ device, and application hints.

*  Software documentation—You may have both application software
and NI-DAQ software documentation. National Instruments (NI)
application software includes LabVIEW, LabWindows/CVI, and
Measurement Studio. After you set up the hardware system, use
either your application software documentation or the NI-DAQ
documentation to help you write your application. If you have a large,
complex system, it is worthwhile to look through the software
documentation before you configure the hardware.

*  One or more of the following help files for software information:

— Start»Programs»National Instruments»NI-DAQ»
NI-DAQmx Help

— Start»Programs»National Instruments»NI-DAQ»
Traditional NI-DAQ User Manual

—  Start»Programs»National Instruments»NI-DAQ»
Traditional NI-DAQ Function Reference Help

* NILVDT/RVDT application notes or tutorials—NI has additional
material about LVDT/RVDTs available at ni.com/support.

You can download NI documents from ni . com/manuals. To download
the latest version of NI-DAQ, click Download Software at ni . com.

© National Instruments 1-3 SCXI-1540 User Manual



Chapter 1 About the SCXI-1540

Electromagnetic Compatibility Guidelines

This product was tested and complies with the regulatory requirements and
limits for electromagnetic compatibility (EMC) as stated in the product
specifications. These requirements and limits are designed to provide
reasonable protection against harmful interference when the product is
operated in its intended operational electromagnetic environment.

This product is intended for use in industrial locations. There is no
guarantee that harmful interference will not occur in a particular
installation, when the product is connected to a test object, or if the product
is used in residential areas. To minimize the potential for the product to
cause interference to radio and television reception or to experience
unacceptable performance degradation, install and use this product in strict
accordance with the instructions in the product documentation.

Furthermore, any changes or modifications to the product not expressly
approved by National Instruments could void your authority to operate it
under your local regulatory rules.

A Caution To ensure the specified EMC performance, operate this product only with
shielded cables and accessories.

Installing Application Software, NI-DAQ, and the

DAQ Device

Refer to the DAQ Getting Started guides packaged with the NI-DAQ
software to install your application software, NI-DAQ driver software, and
the E/M Series DAQ device to which you will connect the SCXI-1540.
NI-DAQ 7.0 or later is required to configure and program the SCXI-1540
module. If you do not have NI-DAQ 7.0 or later, you can either contact a
NI sales representative to request it on a CD or download the latest
NI-DAQ version from ni . com.

@ Note Refer to the Read Me First: Safety and Electromagnetic Compatibility document
before removing equipment covers or connecting or disconnecting any signal wires.

Installing the SCXI-1540 Module into the SCXI Chassis

SCXI-1540 User Manual

Refer to the SCXI Quick Start Guide to install your SCXI-1540 module.
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Connecting the SCXI-1540 in an SCXI Chassis to an E/M Series
DAQ Device for Multiplexed Scanning

Refer to the SCXI Quick Start Guide to install the cable adapter and connect
the SCXI modules to the E/M Series DAQ device.

If you have already installed the appropriate software, refer to Chapter 3,
Configuring and Testing, to configure the SCXI-1540 module(s).

Connecting the SCXI-1540 in a PXI/SCXI Combination Chassis to an
E/M Series DAQ Device for Multiplexed Scanning

Refer to the SCXI Quick Start Guide to connect the SCXI modules to the
E/M Series DAQ device.

If you have already installed the appropriate software, refer to Chapter 3,
Configuring and Testing, to configure the SCXI-1540 module(s).

Verifying the SCXI-1540 Installation in Software

Refer to the SCXI Quick Start Guide for information on verifying the SCXI
installation.

Installing SCXI Using NI-DAQmx in Software

Refer to the SCXI Quick Start Guide for information on installing modules
using NI-DAQmx in software.

Manually Adding Modules in NI-DAQmx

If you did not auto-detect the SCXI modules, you must manually add each
of the modules. Refer to the SCXI Quick Start Guide to manually add
modules.

@ Note NI recommends auto-detecting modules for the first time configuration of the
chassis.

Installing SCXI Using Traditional NI-DAQ (Legacy) in Software

Refer to the SCXI Quick Start Guide for information on installing modules
using Traditional NI-DAQ (Legacy) in software.
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Manually Adding Modules in Traditional NI-DAQ (Legacy)

If you did not auto-detect the SCXI modules, you must manually add each
of the modules. Refer to the SCXI Quick Start Guide to manually add
modules.

@ Note NI recommends auto-detecting modules for the first time configuration of the

chassis.

Verifying and Self-Testing the Installation

The verification procedure for the SCXI chassis is the same for both
NI-DAQmx and Traditional NI-DAQ (Legacy). To test the successful
installation for the SCXI chassis, refer to the SCXI Quick Start Guide.
Verify that the chassis is powered on and correctly connected to an
E/M Series DAQ device.

After verifying and self-testing the installation, the SCXI system should
operate properly with your ADE software. If the test did not complete
successfully, refer to Chapter 3, Configuring and Testing, for
troubleshooting steps.

Troubleshooting the Self-Test Verification

If the self-test verification did not verify the chassis configuration,
complete the steps in this section to troubleshoot the SCXI configuration.

Troubleshooting in NI-DAQmXx

e Ifyou get a Verify SCXI Chassis message box showing the SCXI
chassis model number, Chassis ID: x, and one or more messages
stating Slot Number: x Configuration has module: SCXI-XXXX
or 1540, hardware in chassis is: Empty, take the following
troubleshooting actions:

SCXI-1540 User Manual

Make sure the SCXI chassis is powered on.

Make sure all SCXI modules are properly installed in the chassis.
Refer to the SCXI Quick Start Guide for proper installation
instructions.

Make sure the cable between the SCXI chassis and E/M Series
DAQ device is properly connected.

Inspect the cable connectors for bent pins.
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—  Make sure you are using the correct NI cable assembly.

—  Test the E/M Series DAQ device to verify it is working properly.
Refer to the E/M Series DAQ device help file for more
information.

* If you get a Verify SCXI Chassis message box showing the SCXI
chassis model number, Chassis ID: x, and the message Slot
Number: x Configuration has module: SCXI-XXXX or 1540,
hardware in chassis is: SCXI-YYYY, 1540, or Empty, complete the
following troubleshooting steps to correct the error.

1. Expand the list of NI-DAQmx devices by clicking the + next to
NI-DAQmx Devices.

2. Right-click the SCXI chassis and click Properties to load the
chassis configurator.

3.  Under the Modules tab, ensure that the cabled module is listed in
the correct slot.

4. If the cabled module is not listed in the correct slot, complete the
following troubleshooting steps:

a. If the cabled module is not listed in the correct slot and the
slot is empty, click the drop-down listbox next to the correct
slot and select the cabled module. Configure the cabled
module following the steps listed in the SCXI Quick Start
Guide. Click OK.

b. If another module appears where the cabled module should
be, click the drop-down listbox next to the correct slot and
select the cabled module. A message box appears asking you
to confirm the module replacement. Click OK. Configure the
cabled module following the steps listed in the SCXI Quick
Start Guide. Click OK.

¢ Ensure that you have the highest priority SCXI module cabled to the
E/M Series DAQ device. Refer to the SCXI Quick Start Guide to find
out which SCXI module in the chassis should be cabled to the
E/M Series DAQ device.

*  After checking the preceding items, return to the Troubleshooting the

Self-Test Verification section and retest the SCXI chassis.

If these measures do not successfully configure the SCXI system, contact
NI. Refer to the Signal Conditioning Technical Support Information
document for contact information.
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Troubleshooting in Traditional NI-DAQ (Legacy)

SCXI-1540 User Manual

If you get the message Unable to test chassis at this time,
you have not designated at least one module as connected to a E Series
DAQ device. Refer to the Traditional NI-DAQ (Legacy) section of
Chapter 3, Configuring and Testing, and change the configuration of
the cabled module in the system from Connected to: None to
Connected to: Device x.

If you get the message Failed to find followed by the module
codes and the message Unable to communicate with chassis,
take the following troubleshooting actions:

—  Make sure the SCXI chassis is powered on.

—  Make sure the cable between the SCXI chassis and E Series DAQ
device is properly connected.

— Inspect the cable connectors for bent pins.
—  Make sure you are using the correct NI cable assembly.

—  Test the E Series DAQ device to verify it is working properly.
Refer to the E Series DAQ device help file for more information.

If you get the message Failed to £ind, followed by module codes
and the message Instead found: module with ID OXxx, refer
to the Traditional NI-DAQ (Legacy) section of Chapter 3, Configuring
and Testing, and make sure the correct module is in the specified slot.
Delete the incorrect module as described in Appendix C, Removing the
SCXI-1540, and add the correct module as described in the Traditional
NI-DAQ (Legacy) section of Chapter 3, Configuring and Testing.

If you get the message Failed to f£ind, followed by a module code
and the message Slot x is empty, make sure the configured module
is installed in the specified slot. If not, install the module by following
the instructions in the SCXI Quick Start Guide. If the module is
installed in the correct slot, power off the chassis, remove the module
as specified in Appendix C, Removing the SCXI-1540, and verify that
no connector pins are bent on the rear signal connector. Reinstall the
module as described in the SCXI Quick Start Guide, ensuring

the module is fully inserted and properly aligned in the slot.

After checking the preceding items, return to the Troubleshooting the
Self-Test Verification section and retest the SCXI chassis.

If these measures do not successfully configure the SCXI system, contact
NI. Refer to the Signal Conditioning Technical Support document for
contact information.
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Connecting Signals

This chapter describes how to interface the SCXI-1540 with an LVDT,

RVDT, or resolver.

Connecting to LVDTs and RVDTs

Figures 2-1 and 2-2 show the connections made to a 4-wire and 5-wire
LVDT or RVDT using the SCXI-1540 with the SCXI-1315 terminal block.
Figure 2-1 also shows how you can connect a device with six wires using

only four wires.

Brown

Yellow e

o3| | e

¢ E o Black

Red

? g Blue

CH+

CH

SYNC

GND

EX+

EX

Figure 2-1. 4-Wire Connection to an LVDT or RVDT
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CH+

—»
(e}

Brown Blue o CH

Yellow .;
Grei\_L o
¢ o Black 5 GND

o EX+

Figure 2-2. 5-Wire Connection to an LVDT or RVDT

In general, the 5-wire connection is insensitive to phase shift in the
transducer and wiring, but subject to interference from common-mode
voltages in the cable such as AC hum picked up from power lines,
transformers, and motors. It is advisable, therefore, to use the 4-wire
connection except in cases where a large phase shift in the return signal is
suspected. Causes for a large phase shift might be the use of an operating
frequency other than that specified by the sensor manufacturer, or a cable
length greater than 100 m.

E Note The default configuration setting for the SCXI-1540 is 4-wire. Refer to Chapter 5,
Using the SCXI-1540, for more information about programming the SCXI-1540 in 5-wire
mode.
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Synchronizing Channels

Figure 2-3 shows how to synchronize multiple SCXI-1540 channels to the
same frequency. You should do this for all channels that have wires sharing
a single multi-conductor cable. Synchronization prevents beat frequencies
from appearing in the data. Beat frequencies are the result of channel
oscillators running at slightly different frequencies and coupling into
adjacent channels through cable crosstalk.

e
(0]

CHO+

% o CHO
i Master Channel—
© SYNCO Do not Configure

o GND for External Synchronization

EX0+
EX0

N—e
o o

e
(e}

CH1+

% :l o CH1

E o SYNC1 Slave Channel-
Configure for

GND External Synchronization

o EX1+
EX1

—LJ —LJ

g u——g
(o)

o CH2+
CH2

l
\I——o SYNC2 Slave Channel-

Configure for
External Synchronization

>

GND
EX2+

4_
p\m
o o

o EX2

Figure 2-3. Multiple Channel Synchronization

@ Note To synchronize multiple channels, you must make the connections shown in
Figure 2-3 and configure the slaved channels as externally synchronized. Refer to
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Chapter 5, Using the SCXI-1540, for details about programming the SCXI-1540 for
external synchronization. You must not configure the channel that originates the
synchronization signal from its EX+ pin (channel 0 in the example of Figure 2-3) for
external synchronization since that channel serves as master and is not slaved to any other
channel.

Connecting to Resolvers

Figure 2-4 shows the connections made between a resolver and the
SCXI-1540 using the SCXI-1315 terminal block. A single resolver requires
the use of two channels. You must synchronize both channels using a wire
connecting the EX+ on the master channel to the SYNC on the slave
channel. Configure the slave channel for external synchronization as
described in the Synchronizing Channels section. You can also synchronize
more than two channels used for resolvers or combinations of resolvers,
LVDTs, and RVDTs by the previously described method. Refer to
Chapter 5, Using the SCXI-1540, Figure 5-2, for steps involved in
programming resolvers.

o CHO+

3 o CHO
E cosine o SYNCO Slave Channel-
A stator

Configure for
o GND External Synchronization

o EXO0+
o EX0

:| o CH1+
o CHA1

Master Channel-
o SYNC1 Do not Configure
o GND for External Synchronization

o EX1+

o EX1

Figure 2-4. Resolver Connection
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Pin Assignment

The pin assignment for the SCXI-1540 front signal connector is shown in
Table 2-1. Notice that the positive input terminal for each channel is in
Column C and the negative input terminal is in Column B. The pins labeled
RSVD and PO, P1, ... P7 are reserved. Do not make any connections to these
pins.

A Caution Do not make signal connections to pins in column A of Table 2-1.
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Table 2-1. Front Signal Pin Assignments

Front Connector Diagram Pin Number Column A Column B Column C
32 RSVD CHO- CHO+
Column 31 RSVD GND SYNCO
A B C 30 RSVD EX0- EX 0+
|

32| 0o o o 29 RSVD GND PO

31 | o o o 28 RSVD CHI- CHI1+

0 o o o 27 RSVD GND SYNCI

29 o o o

26 RSVD EX 1- EX 1+

28 o o o

27l o o o 25 RSVD GND Pl

26| 0o o o 24 RSVD CH2- CH?2 +

25| 0 o o 23 RSVD GND SYNC2

2410 o o 2 RSVD EX2- EX2+

23 o o o

21 RSVD GND P2

22 o o [¢)

2910 o o 20 RSVD CH3- CH3+

20| 0o o o 19 RSVD GND SYNC3

19 | o o o 18 RSVD EX3- EX 3+

18 o o o

17 RSVD GND P3

17 o o [¢)

6lo o o 16 RSVD CH4- CH4 +

15 o o o 15 RSVD GND SYNC4

14| 0o o o 14 RSVD EX 4 — EX 4+

B]o o o 13 RSVD GND P4

12 o o o

12 RSVD CH5- CH5 +

11 o o [¢)

0lo o o 11 RSVD GND SYNC5
9| o o o 10 RSVD EX5- EX S5+
8 | o o o 9 RSVD GND P5
719 o o 8 RSVD CH6- CH6+
6 o) (o] o)

7 RSVD GND SYNC6
5 o o] o
4lo o o 6 RSVD EX 6 — EX 6+
3|0 o o 5 RSVD GND P6
2|0 o o 4 RSVD CH7- CH7+
e ° oy 3 RSVD GND SYNC7

2 RSVD EX7- EX7+

1 RSVD GND pP7
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Rear Signal Connector

© National Instruments

The rear signal connector (RSC) is a 50-pin male ribbon-cable connector
used for analog signal connectivity and communication between the
SCXI-1540 and the connected E/M Series DAQ device. The RSC is shown
in Table 2-2. The RSC allows the E/M Series DAQ device to access all
eight differential analog output signals from the SCXI-1540. For 68-pin
E/M Series DAQ devices, you must connect an adapter to the RSC. The
positive terminal of each analog output is named CH X + and the negative
terminal CH X —. Grounding signals AO GND and OUT REEF provide
reference signals needed in the various analog input referencing modes on
the E/M Series DAQ device. In multiplexed mode, the CH 0 signal pair is
used for sending all eight channels of the SCXI-1540, and analog signals
from other modules, to the connected E/M Series DAQ device. If the
module is directly connected to the E/M Series DAQ device, the other
analog channels of the E/M Series DAQ device are unavailable for
general-purpose analog input because they are still connected to the
amplifier outputs of the SCXI-1540 in multiplexed mode.

The communication signals between the E/M Series DAQ device and

the SCXI system are SER DAT IN, SER DAT OUT, DAQ D*/A,

SLOT 0 SEL*, SER CLK, and Al HOLD COMP,I HOLD. The digital
ground, DIG GND on pins 24 and 33, provides a separate ground reference
for the communication signals. SER DAT IN, SER DAT OUT, DAQ D*/A,
SLOT 0 SEL*, and SER CLK are the communication lines for
programming the SCXI-1540. The Al HOLD COMP, AT HOLD, and
SYNC signals are the signals necessary for multiplexed mode scanning. If
the E/M Series DAQ device is connected to the SCXI-1540, these digital
lines are unavailable for general-purpose digital I/O.

2-7 SCXI-1540 User Manual



Chapter 2

Connecting Signals

Table 2-2. Rear Signal Pin Assignments

Rear Connector
Diagram Signal Name Pin Number Pin Number Signal Name
AI GND 1 2 AI GND
CHO + 3 4 CHO-
CH1+ 5 6 CH1-
112 CH2 + 7 8 CH2-
314 CH3+ 9 10 CH3 -
5|6 CH4 + 11 12 CH4 -
718
9 (10 CHS + 13 14 CHS -
)12 CH 6 + 15 16 CH 6 -
13|14
15|16 CH7+ 17 18 CH7-
17118 OUT REF 19 20 —
19120 o1 »
2122 — _
23 | 24 — 23 24 DIG GND
2526 SER DAT IN 25 26 SER DAT OUT
27 | 28
29[ 30 DAQ D*/A 27 28 —
31|32 SLOT 0 SEL* 29 30 —
33|34
3536 — 31 32 —
37 | 38 DIG GND 33 34 —
39 | 40 — 35 36 AI HOLD COMP, AI HOLD
41 |42
43 | 44 SER CLK 37 38 —
45 | 46 . 39 40 o
47 | 48
4950 — 41 42 —
— 43 44 —
— 45 46 SYNC
— 47 48 —
— 49 50 —
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Configuring and Testing

This chapter describes the most frequently used software-configurable
settings for the SCXI-1540.

Common Software-Configurable Settings

Gain/Input Range

v

rms

© National Instruments

This section describes how to set the gain, excitation level, excitation
frequency, wire mode, and external synchronization. Refer to Chapter 4,
Theory of Operation, for a complete list of software-configurable settings.

Gain/input range is a software-configurable setting that allows you to
choose the appropriate amplification to fully utilize the range of the

E/M Series DAQ device. In most applications NI-DAQ chooses and sets
the gain for you as determined by the input range. This feature is described
in Chapter 4, Theory of Operation. Otherwise, you should first determine
the full-scale limits of the SCXI-1540 input signal using the following
formula:

full-scale range) = (excitation level) X (sensor sensitivity) X (sensor full-scale travel)

You then set the upper channel limit to this number and set the lower
channel limit to the negative of this number. For example, if you are using
an LVDT designed to measure +0.3 inches, the manufacturer specified
sensitivity is 1.2 mV/V/mil, and the excitation voltage is set at 3 V , you
obtain a full-scale input voltage of:

+1.08 Ve = (3 Vo) X ((0.0012 V) per Vo per mil) x (£300 mil)

You then set the upper and lower channel input limits to +1.08 V and
—1.08 V, respectively. A mil is equal to 0.001 in.

Refer to Chapter 5, Using the SCXI-1540, for more information about
setting the gain programmatically.
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Excitation Level

The formula for the gain setting is:
(gain setting) = (5 V)/(V,,,, full-scale range)

The maximum output swing of the SCXI-1540 is +5 VDC; therefore, the
gain calculation is 5 V divided by the full-scale limit. Gain, in the case of
the SCXI-1540, is defined as the module DC output voltage divided by the
module AC input voltage where the input voltage is given in units of volts
rms. You should choose the setting that is closest to the calculated value,
but less than the calculated value so that the SCXI-1540 output does not
attempt to go beyond +5 V at full scale.

You may set the excitation at 1 V,; or 3 V... The higher setting is
recommended in all applications except where the driven AC impedance is
less than 95 Q or where the sensor manufacturer recommends a lower
excitation level. Refer to Figure 5-2 in Chapter 5, Using the SCXI-1540, for
information about programming a resolver.

Excitation Frequency

Excitation Source

Wire Mode

You should select the frequency closest to that specified by the sensor
manufacturer. The sensitivity of the sensor can vary considerably from the
specified value if another excitation frequency is used.

The excitation source may only be set to internal.

Select 4-wire for 4-wire connections and 5-wire for 5-wire connections.
Refer to the Connecting to LVDTs and RVDTs section of Chapter 2,
Connecting Signals, for the advantages and disadvantages of each
connection method.

External Synchronization

SCXI-1540 User Manual

Channels that are to be synchronized to the frequency and level of another
channel must have external synchronization enabled. You must also make
a wire connection between the SYNC terminal of the slave channel and the
EX+ terminal of the master channel. Refer to Figure 2-3, Multiple Channel
Synchronization.
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Configurable Settings in MAX

@ Note If you are not using an NI ADE, using an NI ADE prior to version 7.0, or are using
an unlicensed copy of an NI ADE, additional dialog boxes from the NI License Manager
appear allowing you to create a task or global channel in unlicensed mode. These messages
continue to appear until you install version 7.0 or later of an NI ADE.

NI-DAQmx

This section describes where you can access each software-configurable
setting for modification in MAX. The location of the settings varies
depending on the version of NI-DAQ you use. Refer to either the
NI-DAQmx section or the Traditional NI-DAQ (Legacy) section. You also
can refer to the DAQ Getting Started guides and the SCXI Quick Start
Guide for more information on installing and configuring the hardware.
You also can use the DAQ Assistant to graphically configure common
measurement tasks, channels, or scales.

In NI-DAQmzx, you can configure software settings such as voltage
excitation level and frequency, gain/input signal range, wire mode, and
external synchronization in the following ways:

*  Task or global channel in MAX

*  Functions in your application

@ Note All software-configurable settings are not configurable both ways. This section only
discusses settings in MAX. Refer to Chapter 4, Theory of Operation, for information on
using functions in your application.

© National Instruments

These sections describe settings that you can change in MAX and where
they are located. Voltage, LVDT, or RVDT are the NI-DAQmx Task or
NI-DAQmzx Global Channel types you can use with the SCXI-1540.

*  Voltage excitation level and frequency—configure using either
NI-DAQmx Task or NI-DAQmx Global Channel. You also can set
the voltage excitation level and frequency through your application. In
NI-DAQmzx, you can choose 1 or 3 V... The default voltage excitation
in NI-DAQmx is 3 V.. You can also set the frequency between
2.5 and 10 kHz. Refer to Appendix A, Specifications, for the valid
frequencies

* Input signal range—configure the input signal range using either
NI-DAQmx Task or NI-DAQmx Global Channel. When you set the
minimum and maximum range of NI-DAQmx Task or NI-DAQmx
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Global Channel, the driver selects the best gain for the measurement.
You also can set it through your application. The default gain setting
in NI-DAQmx is 1.0. This setting corresponds to an input range of
+5 Vi

Wire mode—you can set the wire mode to either 4-wire or 5-wire
mode as needed by your application.

Modes of operation—configure as multiplexed or parallel mode when
you configure the SCXI chassis. Refer to the SCXI Quick Start Guide
for more information about chassis installation. parallel mode is only
available for the SCXI-1540 when you use NI-DAQmx.

@ Note Refer to Chapter 4, Theory of Operation, for information on configuring the settings
for your application using NI-DAQmx.

SCXI-1540 User Manual

Creating an LVDT/RVDT Global Channel or Task in
NI-DAQmx

To create a new NI-DAQmx LVDT/RVDT global task or channel,
complete the following steps:

1.
2.

N ook

10.

Double-click Measurement & Automation on the desktop.
Right-click Data Neighborhood and select Create New.

Select NI-DAQmx Task or NI-DAQmx Global Channel, and click
Next.

Select Analog Input.
Select Position.
Select LVDT or RVDT.

If you are creating a task, you can select a range of channels by holding
down the <Shift> key while selecting the channels. You can select
multiple individual channels by holding down the <Ctrl> key while
selecting channels. If you are creating a channel, you can only select
one channel. Click Next.

Name the task or channel and click Finish.

In the Channel List box, select the channel(s) you want to configure.
You can select a range of channels by holding down the <Shift> key
while selecting the channels. You can select multiple individual
channels by holding down the <Ctrl> key while selecting channels.

Enter the specific values for your application in the Settings tab.
Context help information for each setting is provided on the right side
of the screen.
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11.

12.

Chapter 3 Configuring and Testing

Click the Device tab and select the autozero mode and whether or not
you want synchronization enabled.

If you are creating a task and want to set timing or triggering controls,
enter the values in the Task Timing and Task Triggering tabs.

Traditional NI-DAQ (Legacy)

In Traditional NI-DAQ (Legacy), you can configure software settings such
as voltage excitation level and frequency, gain/input signal range, wire
mode, and external synchronization in the following ways:

Module property pages in MAX
Virtual channels properties in MAX

Functions in your ADE

@ Note All software-configurable settings are not configurable in all three ways. This
section only discusses settings in MAX. Refer to Chapter 4, Theory of Operation, for
information on using functions in your application.

Most of these settings are available in module properties and/or using
LVDT/RVDT virtual channels:

Wire mode—you can set the wire mode to either 4-wire or 5-wire
mode as needed by your application.

@ Note Refer to Chapter 4, Theory of Operation, for information on configuring the settings
for your application using Traditional NI-DAQ (Legacy).

Configuring Module Property Pages

1.

© National Instruments

Right-click the SCXI-1540 module you want to configure and select
Properties. Click General.

If the module you are configuring is connected to an E Series DAQ
device, select that device by using Connected to. If you want this

E Series DAQ device to control the chassis, confirm there is a check in
the This device will control the chassis checkbox. If the module you
are configuring is not connected to an E Series DAQ device, select
None.

Click the Channel tab. Select the appropriate gain, excitation voltage,
sensor wire mode, excitation frequency, and whether or not you want
to use external synchronization for each channel. If you want to
configure all the channels at the same time, select the Channel
drop-down menu, scroll to the bottom, and select All Channels. Refer
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SCXI-1540 User Manual

to the Common Software-Configurable Settings section for a detailed
description of each setting. Click Apply.

Click Accessory. Select the accessory you connected to the module.
When configuration is complete, click OK.

The Traditional NI-DAQ (Legacy) chassis and SCXI-1540 should now be
configured properly. If you need to change the module configuration,
right-click the module and repeat steps 1 through 4. Test the system
following the steps in the Troubleshooting the Self-Test Verification
section of Chapter 1, About the SCXI-1540.

Creating an LVDT/RVDT Virtual Channel

To create an LVDT/RVDT virtual channel, complete the following steps:

A

Right-click Data Neighborhood and select Create New.
Select Traditional NI-DAQ Virtual Channel and click Finish.
Select Analog Input from the drop-down menu and click Next.
Enter the Channel Name and Channel Description, and click Next.
Select LVDT/RVDT from the drop-down menu and click Next.
Enter the following information:
a. Physical unit
b. Sensitivities unit from the drop-down menu
c. Sensitivity
d. Measurement range min and max
Click Next.
Enter the following information:

What DAQ hardware will be used? from the drop-down menu

b. 'What channel on your DAQ hardware? from the drop-down
menu

c.  Which analog input mode will be used? from the drop-down
menu

d. Whatis the Excitation Voltage’s source and value? from the
drop-down menu

e. Voltage in volts rms
Click Finish.
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Verifying the Signal

This section describes how to take measurements using test panels in order
to verify signal, and configuring and installing a system in NI-DAQmx and
Traditional NI-DAQ (Legacy).

Verifying the Signal in NI-DAQmx Using a Task or Global Channel

You can verify the signals on the SCXI-1540 using NI-DAQmx by
completing the following steps:

1. Expand the list of tasks and virtual channels by clicking the + next to
Data Neighborhood.

2. Click the + next to NI-DAQmx Tasks to expand the list of tasks.
Click the task.

4. Add or remove channels, if applicable, in the Channel List. Click the
oz Add Channels button, shown at left, and select the type of channel you
"I want to add.

a. Inthe window that appears, expand the list of channels by clicking
the + next to the module of interest.

b. Select the channel(s) you want to verify. You can select a block of
channels by holding down the <Shift> key or multiple channels by
holding down the <Ctrl> key. Click OK.

Enter the appropriate information on the Settings tab.

Click the Device tab and enter the appropriate information on the
Device tab.

7. Click the Test button to open the test panel.
Click the Start button, if necessary.

9. After you have completed verifying the channels, close the test panel
window.

You have now verified the SCXI-1540 configuration and signal connection.

@ Note For more information on how to further configure the SCXI-1540, or how to use
LabVIEW to configure the module and take measurements, refer to Chapter 4, Theory of
Operation.
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Verifying the Signal in Traditional NI-DAQ (Legacy)

SCXI-1540 User Manual

This section discusses how to verify the signal in Traditional NI-DAQ
(Legacy) using channel strings and virtual channels.

Verifying the Signal Using Channel Strings
The format of the channel string is as follows:

obx ! scy ! mdz ! channel

where

* obx is the onboard E Series DAQ device channel, with x representing
a particular channel where the multiplexed channels are sent. This
value is 0 for E Series DAQ device channel O in a single-chassis
system. In a multichassis or remote chassis system, the E Series DAQ
device channel x corresponds to chassis number n — 1, where E Series
DAQ device channel x is used for scanning the nth chassis in the
system.

e scy is the SCXI chassis ID, where y is the number you chose when
configuring the chassis.

* mdz is the slot position where the module is located, with z being the
particular slot number. The slots in a chassis are numbered from left to
right, starting with 1.

e channel is the channel that is sampled from module z.

Use the format obx ! scy ! mdz ! nto verify the signal, where n is a
single input channel.

Complete the following steps to use channel strings in verifying the signal:

1. Expand the list of tasks and virtual channels by clicking the + next to
Devices and Interfaces.

2. Click the + next to Traditional NI-DAQ Devices to expand the device
list.

Right-click the appropriate E Series DAQ device.
Click Test Panels.

Enter the channel string.

Enter the input limits.

Select the Data Mode.

Select the Y Scale Mode.
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Chapter 3 Configuring and Testing

Refer to the LabVIEW Measurements Manual for more information and for
proper formatting of channel strings for different uses.

Verifying the Signal Using LVDT/RVDT Virtual
Channel

If you have already created a virtual channel, complete the following steps
to verify the signal:

1. Right-click the virtual channel you want to verify and select Test.
2. In Channel Names, select the channel you want to verify.

3. When you have completed verifying the channel, click Close.
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Theory of Operation

This chapter discusses LVDT, RVDT, resolver concepts, and the
SCXI-1540.

LVDTs, RVDTs, and Resolvers

© National Instruments

An LVDT is a device for measuring linear position. Figure 4-1 shows a
cut-away view of an LVDT.
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Figure 4-1. Cut-Away View of an LVDT

The primary winding, located at center, is excited with a sine-wave voltage.
The resulting magnetic field is coupled through the movable core into the
secondary windings located on either side of the primary. With the core at
center, both secondaries have the same induced voltage. With the series
connection and polarity shown, the resulting output signal is zero. If the
core moves to the left, the left secondary is more strongly coupled to the
primary than the right secondary, resulting in a stronger induced voltage in
the left secondary and an output signal that is in phase with the primary
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Chapter 4 Theory of Operation

excitation voltage. The more the core moves off center, the stronger the
imbalance and the greater the output signal. Moving the core to the left of
center results in the same behavior, but with the output signal out of phase
with the excitation signal. Figure 4-2 shows these core locations and the
resulting induced voltage and phase.
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Figure 4-2. LVDT Core Locations with Resulting Induced Voltage and Phase
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Chapter 4 Theory of Operation

LVDTs are frequently used in applications where ruggedness, operation
over large temperature ranges, insensitivity to contamination, or long life
are important considerations. They are extremely reliable in harsh
conditions.

An RVDT is simply the rotational version of an LVDT. The angular
measurement range of typical RVDTs is between +30° and +70°.

Resolvers are similar to RVDTs, but employ secondaries at right angles that
produce two simultaneous signal voltages proportional to the sine and
cosine of the shaft angle. Thus, resolvers can measure over 360° of rotation
and do not need to pass through 0° before making absolute position
measurements, as is required by quadrature encoders.

Like LVDTs and RVDTs, resolvers are advantageous in hostile operating
environments. Resolvers are often easier to use than RVDTs. You can
originate the 0° position arbitrarily in software without the need to
physically rotate the sensor into position. Since all that is needed to convert
measured voltages to degrees is an arctangent function, there are no scaling
considerations.

SCXI-1540 Theory of Operation

SCXI-1540 User Manual

Figure 4-3 is a block diagram of the SCXI-1540. Each channel has an
oscillator that generates a sine wave signal at a user-selected frequency
between 2.5 kHz and 10 kHz. The oscillator signal passes through an
amplifier with a gain of 1 or 1/3, depending upon the configuration setting
of 3V, cor 1V respectively. If external synchronization is not enabled,
the excitation signal is routed to the output buffer and then to the front
signal connector pins EX+ and EX-. The output buffers are power
amplifiers with a very low output impedance used for differentially driving
an LVDT. EX- is 180° out of phase with EX+ so that a balanced signal is
available to the LVDT secondary. If external synchronization is enabled,
the buffered output signal to EX+ and EX- is obtained from the SYNC
terminal on the front signal connector. This terminal connects to the EX+
terminal of a different channel that serves as master. Thus the frequency
and phase of all slave channels are forced to be the same as the master. The
level settings pass from the master to the slaves. Changing the level settings
of the slave channels has no effect.
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Chapter 4 Theory of Operation

The LVDT returns a signal whose phase and amplitude is related to the
position of the movable core. The return signal connects across the CH +
and CH — terminals on the front signal connector. In normal operation, this
signal passes through the input selection switch to the differential amplifier
where the common-mode signal on the input wires is rejected. The signal
then passes to a variable gain stage that is set to a gain that best covers the
expected signal range for the particular LVDT in use. The signal then
passes to a block where it is multiplied by the excitation signal. The output
of the multiplier is the product of two sine waves at the same frequency.
Two signals result—a DC signal proportional to input magnitude or,
equivalently, LVDT core position, and a double-frequency signal. The
lowpass filter removes the double-frequency signal. Only the DC signal
passes through, which is the final output signal for the particular channel.
The analog multiplexer routes a particular channel output to either the
SCXIbus connector or the rear signal connector. The SCXI-1540 features
random scanning, meaning you can scan channels in any order.

The input selector switch allows calibration software to disconnect the
differential amplifier from the front signal connector and reconnect it to
the ground or excitation signal at either phase. It is therefore possible to
calibrate gain and offset of the module with the module deployed in a test
setup. You need not remove the field wiring. Calibration constants are
stored in an onboard EEPROM and automatically used in the driver when
scaling the signal.

Modes of Operation

SCXI-1540 User Manual

The SCXI-1540 provides two modes of operation for passing the
conditioned signals to the digitizing E/M Series DAQ device—multiplexed
mode and parallel mode.

Theory of Multiplexed Mode Operation

In multiplexed mode, all input channels of an SCXI module are
multiplexed into a single analog input channel of the E/M Series DAQ
device. Multiplexed mode operation is ideal for high channel count
systems. Multiplexed mode is typically used for performing scanning
operations with the SCXI-1540. The power of SCXI multiplexed mode
scanning is its ability to route many input channels to a single channel of
the E/M Series DAQ device.

The multiplexing operation of the analog input signals is performed
entirely by multiplexers in the SCXI modules, not inside the E/M Series
DAQ device or SCXI chassis. In multiplexed mode, the SCXI-1540
scanned channels are kept by the NI-DAQ driver in a scan list. Immediately
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prior to a multiplexed scanning operation, the SCXI chassis is programmed
with a module scan list that controls which module sends its output to the
SCXIbus during a scan through the cabled SCXI module.

The list can contain channels in any physical order and the multiplexer can
sequence the channel selection from the scan list in any order. The ordering
of scanned channels need not be sequential. Channels can occur multiple
times in a single scan list. The scan list can contain an arbitrary number
of channels for each module entry in the scan list, limited to a total of
512 channels per E/M Series DAQ device. This is referred to as flexible
scanning (random scanning). Not all SCXI modules provide flexible
scanning.

The module includes first-in first-out (FIFO) memory for storing the
channel scan list defined in your application code. NI-DAQ drivers load the
FIFO based on the channel assignments you make in your application. You
need not explicitly program the module FIFO as this is done automatically
for you by the NI-DAQ driver.

When you configure a module for multiplexed mode operation, the routing
of multiplexed signals to the E/M Series DAQ device depends on which
module in the SCXT system is cabled to the E/M Series DAQ device. There
are several possible scenarios for routing signals from the multiplexed
modules to the E/M Series DAQ device.

If the scanned SCXI-1540 module is not directly cabled to the E/M Series
DAQ device, the module sends its signals through the SCXIbus to the
cabled module. The cabled module, whose routing is controlled by the
SCXI chassis, routes the SCXIbus signals to the E/M Series DAQ device
through the CH 0 pin on its rear signal connector.

If the E/M Series DAQ device scans the cabled module, the module routes
its input signals through the CH 0 pin on its rear signal connector to the
E/M Series DAQ device CH 0.

Multiplexed mode scanning acquisition rates have limitations that are
determined based on the hardware in the system, and the mode of
operation. The maximum multiplexing rate of SCXI is 333 kHz. If the
E/M Series DAQ device can sample more quickly than 333 kHz, then the
maximum multiplexing rate of SCXI is the limiting factor. If the E/M Series
DAQ device cannot sample at 333 kS/s, the sample rate of the E/M Series
DAQ device is the limiting factor on the maximum acquisition rate of the
system in multiplexed mode operation.
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Chapter 4 Theory of Operation

Scaling LVDT and RVDT Data Using the SCXI-1540

When using an LVDT or RVDT, the fundamental measurement quantities
of interest are usually linear or angular position, or some quantity derived
from a position measurement. Converting the SCXI-1540 voltage output
signals to these more fundamental quantities involves scaling.

The easiest way to obtain scaled data from the SCXI-1540 is to use a
NI-DAQmx task or a Traditional NI-DAQ (Legacy) virtual channel. When
using a task or channel in your application, the data is already scaled based
on the information you entered when creating the task or channel. Your
application need not perform any additional scaling.

In other cases, the analog input data read by your application has only been
scaled to equal the rms voltage present at the analog input terminals of the
SCXI-1540. This data is a signed quantity with the sign determined by the
phase (0° or 180°), even though the units are in volts rms. If you choose to
acquire the raw data in volts, you must scale the data in your application
using the following formula:

SCXI-1540 data in volts rms
(excitation setting in volts rms) X (sensor sensitivity)

scaled data =

For example, if you are working with an LVDT with a
manufacturer-specified sensitivity of 1.2 mV/V/mil (or equivalently,
0.0012 V/V/mil) and the excitation level of the corresponding SCXI-1540
channel is 3 V,, the conversion formula is:

(SCXI-1540 data in volts rms)
3V,,.s X (0.0012 volts per volt per mil) x (1000 mils per inch)

scaled data, in inches =

_ (SCXI-1540 data in volts rms)
B (3.6 volts per inch)

= (SCXI-1540 data in volts rms) X (0.278 inch per volt)

Converting Resolver Data to Angular Position

Converting resolver data to angular position is accomplished by simply
passing the data from the two channels to a four-quadrant arctangent
function, such as the LabVIEW function Inverse Tangent (2 Input).
This function is on the Trigonometric subpalette. To access this function,
select Function»Numeric»Trigonometric.

SCXI-1540 User Manual 4-8 ni.com



© National Instruments

Chapter 4 Theory of Operation

Theory of Parallel Mode Operation

Parallel mode is ideal for high speed acquisitions. In parallel mode, the
eight conditioned analog output signals at the rear signal connector of the
SCXI-1540, shown in Figure 4-3, are connected directly to the eight analog
input channels on the E/M Series DAQ device. When the SCXI-1540
operates in parallel mode, the E/M Series DAQ device performs
multiplexed scans of the SCXI-1540 parallel outputs. The SCXI-1540
module does not multiplex the channels.

Traditional NI-DAQ (Legacy) driver software can only control the
SCXI-1540 module in multiplexed mode. NI-DAQmzx can operate the
SCXI-1540 in both multiplexed and parallel mode.

In parallel mode, SCXI-1540 channels 0 through 7 conditioned outputs are
passed directly to E/M Series DAQ device channels 0 through 7. The
E/M Series DAQ device channels should be configured for differential
input mode.

Parallel mode operation acquisition rates have limitations that are
determined based on the E/M Series DAQ device you are using. The
maximum sampling rate is determined by the maximum sample rate of the
E/M Series DAQ device. The 333 kHz maximum SCXI multiplexing rate
is not a limitation in parallel mode operation. Therefore, if the E/M Series
DAQ device can sample more quickly than 333 kHz, the SCXI-1540
configured for parallel mode operation is not the limiting factor.
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This chapter makes suggestions for developing your application and
provides basic information regarding calibration.

Developing Your Application in NI-DAQmx

@ Note If you are not using an NI ADE, using an NI ADE prior to version 7.0, or are using
an unlicensed copy of an NI ADE, additional dialog boxes from the NI License Manager
appear allowing you to create a task or global channel in unlicensed mode. These messages
continue to appear until you install version 7.0 or later of an NI ADE.

This section describes how to configure and use NI-DAQmx to control the
SCXI-1540 in LabVIEW, LabWindows/CVI, and Measurement Studio.
These ADEs provide greater flexibility and access to more settings than
MAX, but you can use ADEs in conjunction with MAX to quickly create a
customized application.

Typical Program Flowchart

Figure 5-1 shows a typical program LVDT/RVDT flowchart for creating a
task to configure channels, take a measurement, analyze the data, present
the data, stop the measurement, and clear the task. Figure 5-2 shows a
similar flowchart for a resolver.
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Figure 5-1. Typical Program Flowchart for LVDT or RVDT Channels
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Figure 5-2. Typical Program Flowchart for Resolver Channels
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@ Note Refer to Chapter 2, Connecting Signals, Figure 2-4, for physical connections.

General Discussion of Typical Flowchart

SCXI-1540 User Manual

The following sections briefly discuss some considerations for a few of the
steps in Figure 5-1. These sections are meant to give an overview of some
of the options and features available when programming with NI-DAQmx.

Creating a Task Using DAQ Assistant or
Programmatically

When creating an application, you must first decide whether to create the
appropriate task using the DAQ Assistant or programmatically in the ADE.

Developing your application using DAQ Assistant gives you the ability to
configure most settings such as measurement type, selection of channels,
excitation voltage, signal input limits, task timing, and task triggering. You
can access the DAQ Assistant through MAX or your NI ADE. Choosing to
use the DAQ Assistant can simplify the development of your application.
NI recommends creating tasks using the DAQ Assistant for ease of use,
when using a sensor that requires complex scaling, or when many
properties differ between channels in the same task.

If you are using an ADE other than an NI ADE, or if you want to explicitly
create and configure a task for a certain type of acquisition, you can
programmatically create the task from your ADE using functions or VIs.
If you create a task using the DAQ Assistant, you can still further configure
the individual properties of the task programmatically with functions

or property nodes in your ADE. NI recommends creating a task
programmatically if you need explicit control of programmatically
adjustable properties of the DAQ system.

Programmatically adjusting properties for a task created in the DAQ
Assistant overrides the original, or default, settings only for that session.
The changes are not saved to the task configuration. The next time you load
the task, the task uses the settings originally configured in the DAQ
Assistant.

Adjusting Timing and Triggering

There are several timing properties that you can configure through the
DAQ Assistant or programmatically using function calls or property nodes.
If you create a task in the DAQ Assistant, you can still modify the timing
properties of the task programmatically in your application.
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When programmatically adjusting timing settings, you can set the task to
acquire continuously, acquire a buffer of samples, or acquire one point at a
time. For continuous acquisition, you must use a while loop around the
acquisition components even if you configured the task for continuous
acquisition using MAX or the DAQ Assistant. For continuous and buffered
acquisitions, you can set the acquisition rate and the number of samples to
read in the DAQ Assistant or programmatically in your application. By
default, the clock settings are automatically set by an internal clock based
on the requested sample rate. You also can select advanced features such as
clock settings that specify an external clock source, internal routing of the
clock source, or select the active edge of the clock signal.

Configuring Channel Properties

All ADEs used to configure the SCXI-1540 access an underlying set of
NI-DAQmzx properties. Table 5-1 shows some of these properties. You can
use Table 5-1 to determine what kind of properties you need to set to
configure the module for your application. For a complete list of
NI-DAQmx properties, refer to your ADE help file.

@ Note You cannot adjust some properties while a task is running. For these properties, you
must stop the task, make the adjustment, and re-start the application. Table 5-1 assumes all
properties are configured before the task is started.

Table 5-1. NI-DAQmx Properties

Property Short Name Description

Analog Input»General Properties» AlLRng.High Specifies the upper

Advanced»Range»High limit of the input range
on the digitizer device.

Analog Input»General Properties» Al.Rng.Low Specifies the lower

Advanced»Range»Low limit of the input range
on the digitizer device.

Analog Input»General Properties» AlLExcit.Val Specifies the amount

Signal Conditioning»Excitation» of excitation in RMS

Value volts.

Analog Input»General Properties» ALLACExcit.Freq Specifies the

Signal Conditioning»Excitation» frequency of AC

AC Excitation»Frequency excitation.
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Table 5-1. NI-DAQmx Properties (Continued)

Property

Short Name

Description

Analog Input»General Properties»
Signal Conditioning»Excitation»
AC Excitation»Synchronization
Enable

AL ACExcit.SyncEnable

Specifies whether to
synchronize the AC
excitation source of the
channel to that of
another channel.

Analog Input»General Properties» AL ACExcit.WireMode Specifies the number
Signal Conditioning»Excitation» of leads on the LVDT
AC Excitation»Wire Mode or RVDT.
Analog Input»General Properties» Al Gain Specifies a gain factor
Advanced»Gain and Offset»Gain to apply to the signal
Value conditioning portion
of the channel.
Analog Input»General Properties» Al.AutoZeroMode Specifies when to
Advanced»High Accuracy Settings» measure ground.
Auto Zero Mode NI-DAQmx then
subtracts the voltage
either on every sample
or only once,
depending on the
setting.
Analog Input»Measurement Type Al.MeasType Indicates the

(read only)

measurement to take
with the analog input
channel.

@ Note This is not a complete list of NI-DAQmx properties and does not include every
property you may need to configure your application. It is a representative sample of
important properties to configure for LVDT/RVDT measurements. For a complete list of
NI-DAQmzx properties and more information about NI-DAQmzx properties, refer to your

ADE help file.

SCXI-1540 User Manual
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Acquiring, Analyzing, and Presenting

After configuring the task and channels, you can start the acquisition, read
measurements, analyze the data returned, and display it according to the
needs of your application. Typical methods of analysis include digital
filtering, averaging data, performing harmonic analysis, applying a custom
scale, or adjusting measurements mathematically.

NI provides powerful analysis toolsets for each NI ADE to help you
perform advanced analysis on the data without requiring you to have a
programming background. After you acquire the data and perform any
required analysis, it is useful to display the data in a graphical form or log
itto a file. NI ADEs provide easy-to-use tools for graphical display, such as
charts, graphs, slide controls, and gauge indicators. NI ADEs have tools
that allow you to easily save the data to files such as spread sheets for easy
viewing, ASCII files for universality, or binary files for smaller file sizes.

Completing the Application

After you have completed the measurement, analysis, and presentation of
the data, it is important to stop and clear the task. This releases any memory
used by the task and frees up the DAQ hardware for use in another task.

@ Note In LabVIEW, tasks are automatically cleared when the program is stopped.

Developing an Application Using LabVIEW

This section describes in more detail the steps shown in the typical program
flowchart in Figure 5-1, such as how to create a task in LabVIEW and
configure the channels of the SCXI-1540. If you need more information or
for further instructions, select Help» VI, Function, & How-To Help from
the LabVIEW menu bar.

@ Note Except where otherwise stated, the VIs in Table 5-2 are located on the Functions»
All Functions»NI Measurements»DAQmx - Data Acquisition subpalette and
accompanying subpalettes in LabVIEW.

© National Instruments 5-7 SCXI-1540 User Manual
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Table 5-2. Programming a Task in LabVIEW

Flowchart Step

VI or Program Step

Create Task in DAQ Assistant

Create a DAQmx Task Name Control located on the
Controls»All Controls»I/O»DAQmx Name Controls
subpalette, right-click it, and select New Task (DAQ
Assistant).

Create a Task
Programmatically (optional)

DAQmx Create Task.vi located on the Functions»

All Functions»NI Measurements»DAQmx - Data
Acquisition»DAQmx Advanced Task Options
subpalette—This VI is optional if you created and configured
your task using the DAQ Assistant. However, if you use it in
LabVIEW, any changes you make to the task will not be saved to
a task in MAX.

Create LVDT or RVDT
Channels

DAQmx Create Virtual Channel.vi (Al Voltage by default,
to change, click AI Voltage and select Analog Input»
Position»LVDT or Analog Input»Position>RVDT.)—This VI
is optional if you created and configured your task and channels
using the DAQ Assistant. Any channels created with this VI are
not saved in the DAQ Assistant. They are only available for the
present session of the task in LabVIEW.

Adjust Timing Settings
(optional)

DAQmx Timing.vi (Sample Clock by default)—This VI is
optional if you created and configured your task using the DAQ
Assistant. Any timing settings modified with this VI are not
saved in the DAQ Assistant. They are only available for the
present session of the task in LabVIEW.

Configure Channels (optional)

DAQmx Channel Property Node, refer to the Using a DAQmx
Channel Property Node in LabVIEW section for more
information. This step is optional if you created and fully
configured the channels using the DAQ Assistant. Any channel
modifications made with a channel property node are not saved
in the task in the DAQ Assistant. They are only available for the
present session of the task in LabVIEW.

Start Measurement

DAQmx Start Task.vi

Read Measurement

DAQmx Read.vi

Analyze Data

Some examples of data analysis include filtering, scaling,
harmonic analysis, or level checking. Some data analysis tools
are located on the Functions»Signal Analysis subpalette and on
the Functions»All Functions»Analyze subpalette.

SCXI-1540 User Manual
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Table 5-2. Programming a Task in LabVIEW (Continued)

Flowchart Step

VI or Program Step

Display Data

You can use graphical tools such as charts, gauges, and graphs
to display your data. Some display tools are located on the
Controls»All Controls»Numeric»Numeric Indicators
subpalette and Controls»All Controls»Graph subpalette.

Continue Sampling

For continuous sampling, use a While Loop. If you are using
hardware timing, you also need to set the DAQmx Timing.vi
sample mode to Continuous Samples. To do this, right-click the
terminal of the DAQmx Timing.vi labeled sample mode and
click Create»Constant. Click the box that appears and select
Continuous Samples.

Stop Measurement

DAQmx Stop Task.vi (This VIis optional, clearing the task
automatically stops the task.)

Clear Task

DAQmx Clear Task.vi

Using a DAQmx Channel Property Node in LabVIEW

You can use property nodes in LabVIEW to manually configure the
channels. To create a LabVIEW property node, complete the following

steps:

1. Launch LabVIEW.

2. Create the property node in a new VI or in an existing VI.
3. Open the block diagram view.

4. From the Functions toolbox, select All Functions»

NI Measurements»DAQmx - Data Acquisition, and select
DAQmx Channel Property Node.

The ActiveChans property is displayed by default. This allows you to
specify exactly what channel(s) you want to configure. If you want to
configure several channels with different properties, separate the lists
of properties with another Active Channels box and assign the
appropriate channel to each list of properties.

Note If you do not use Active Channels, the properties are set on all of the channels in

the task.

© National Instruments

6.

Right-click ActiveChans, and select Add Element. Left-click the new
ActiveChans box. Navigate through the menus, and select the
property you wish to define.
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Change the property to read or write to either get the property or write
a new value. Right-click the property, go to Change To, and select
Write, Read, or Default Value.

After you have added the property to the property node, right-click the
terminal to change the attributes of the property, add a control,
constant, or indicator.

g == DACme: Channel g
1 3
2500 4

Figure 5-3. LabVIEW Channel Property Node with AC Excitation
at 1 Volt RMS and AC Excit Frequency at 2500 Hz

9. To add another property to the property node, right-click an existing

property and left-click Add Element. To change the new property,
left-click it and select the property you wish to define.

@ Note Refer to the LabVIEW Help for information about property nodes and specific
NI-DAQmx properties.

Specifying Channel Strings in NI-DAQmx

Use the channel input of DAQmx Create Channel to specify the
SCXI-1540 channels. The input control/constant has a pull-down menu
showing all available external channels. The strings take one of the
following forms:

SCXI-1540 User Manual

single device identifier/channel number—for example SC1Mod1/ch0

multiple, noncontinuous channels—for example SC1Mod1 /cho,
SC1Modl/ch4

multiple continuous channels—for example SC1Modl/ch0:4
(channels O through 4)

When you have a task containing SCXI-1540 channels, you can set the
properties of the channels programmatically using the DAQmx Channel
Property Node.
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Follow the general programming flowchart or open an example to build a
basic LVDT/RVDT virtual channel. You can use property nodes in
LabVIEW to control, configure, and customize the NI-DAQmx task and
SCXI-1540. To create a LabVIEW property node, complete the following
steps:

1.
2.

Launch LabVIEW.

Create the property node in a new Virtual Instrument (VI) or in an
existing VL.

Open the block diagram view.

From the Functions tool bar, select NI Measurements,
DAQmx - Data Acquisition, and select the type of property node you
wish to configure.

Left-click inside the property box and select ActiveChans. This allows
you to specify what channel(s) you want to configure. If you want to
configure several channels with different properties, separate the lists
of properties with another ActiveChans box, and assign the
appropriate channel to each list of properties.

Right-click ActiveChans and select Add Element. Left-click the new
ActiveChans box. Navigate through the menus and select the property
you wish to define.

You must change the property to read or write to either get the property
or write a new value. Right-click the property, go to Change To, and
select Write, Read, or Default Value.

After you have added the property to the property node, right-click
the terminal to change the attributes of the property, add a control,
constant, or indicator.

To add another property to the property node, right-click an existing
property and left-click Add Element. To change the new property,
left-click it and select the property you wish to define.

@ Note Refer to the LabVIEW Help for information about property nodes and specific
NI-DAQmzx properties.

Text Based ADEs

You can use text based ADEs such as LabWindows/CVI, Measurement
Studio, Visual Basic 6, .NET, and C# to create code for using the
SCXI-1540.

© National Instruments
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LabWindows/CVI

LabWindows/CVI works with the DAQ Assistant in MAX to generate
code for an LVDT/RVDT task. You can then use the appropriate function
call to modify the task. To create a configurable channel or task in
LabWindows/CVI, complete the following steps:

1. Launch LabWindows/CVI.

2. Open a new or existing project.

3. From the menu bar, select Tools»Create/Edit DAQmx Tasks.
4

Choose Create New Task In MAX or Create New Task In Project
to load the DAQ Assistant.

5. The DAQ Assistant creates the code for the task based on the
parameters you define in MAX and the device defaults. To change
a property of the channel programmatically, use the
DAQmxSetChanAttribute function.

@ Note Refer to the NI LabWindows/CVI Help for more information on creating NI-DAQmx
tasks in LabWindows/CVI and NI-DAQmx property information.

SCXI-1540 User Manual

Measurement Studio (Visual Basic 6, .NET, and C#)

When creating an LVDT/RVDT task in Visual Basic 6, .NET and C#,
follow the general programming flow in Figure 5-1. You can then use
the appropriate function calls to modify the task. This example creates a
new task and configures an NI-DAQmx LVDT/RVDT channel on the
SCXI-1540. You can use the same functions for Visual Basic 6, NET
and C#.

In this example, an analog input channel object is used since reading the
voltage from an LVDT is an analog input operation. The following text is a
function prototype example:

void AIChannelCollection.CreateLVDTChannel (
System.String physicalChannelName,
System.String nameToAssignChannel,
System.Double minVal,
System.Double maxVal,
AILVDTUnits lvdtUnits,
System.Double sensitivity,
AISensitivityUnits sensitivityUnits,
AIExcitationSource voltExcitSource,
System.Double voltExcitVval,
System.Double voltExcitFreq,
AIACExcitWireMode acExcitWireMode) ;
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To actually create and configure the channel, you would enter something
resembling the following example code:

Task myTask = new
NationalInstruments.DAQmx.Task (*myTaskName”) ;
MyTask.DAQmxCreateAIPosLVDTChan (
“SClModl/ai0”, // System.String physicalChannelName
“1vdt0”, // System.String nameToAssignChannel
-0.001, // System.Double minVal
0.001, // System.Double maxVal
ATLVDTUnits.Inches, // AIRVDTUnits 1lvdtUnits
1.0, // System.Double
AISensitivityUnits.MvVolts/Volt/0.001linch, //
AISensitivityUnits sensitivityUnits
AIExcitationSourceInternal, // AIExcitationSource
voltExcitSource
1.0, // System.Double voltExcitUnit
2500, // System.Double voltExcitFreqg
ATACExcitWireMode.4Wire, // AIACExcitWireMode
acExcitWireMode) ;
// setting attributes after the channel is created
AIChannel myChannel = myTask.AIChannels[“LVDT0”];
myChannel .AutoZeroMode = AIAutoZeroMode.Once;

You can change any of the properties at a later time. For example, to change
the excitation value of myChannel, enter the following lines:

AIChannel myChannel = myTask.AIChannels[“LVDT 0”];
myChannel .Excitationvalue = 3.0;

Modify the example code above or the code from one of the shipping
examples as needed to suit your application. Refer to the Other Application
Documentation and Material section for the location of program examples.

@ Notes You can create and configure the LVDT/RVDT task in MAX and load it into your
application with the function call
NationalInstruments.DAQmx.DagSystem.Local .LoadTask.

Refer to the NI Measurement Studio Help for more information on creating NI-DAQmx
tasks in LabWindows/CVI and NI-DAQmx property information.
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Programmable NI-DAQmx Properties

All of the different ADEs that configure the SCXI-1540 access an
underlying set of NI-DAQmx properties. Table 5-1 provides a list of some
of the properties that configure the SCXI-1540. You can use this list to
determine what kind of properties you need to set to configure the device
for your application. For a complete list of NI-DAQmx properties, refer to
your ADE help file.

@ Note Table 5-1 is not a complete list of NI-DAQmzx properties and does not include every
property you may need to configure LVDTs, RVDTs, and resolvers. It is a representative
sample of important properties to configure LVDTs, RVDTs, and resolvers. For a complete
list of NI-DAQmx properties and more information on NI-DAQmx properties, refer to your

ADE help file.

Developing Your Application in Traditional NI-DAQ

(Legacy)

@ Note If you are not using an NI ADE, using an NI ADE prior to version 7.0, or are using
an unlicensed copy of an NI ADE, additional dialog boxes from the NI License Manager
appear allowing you to create a task or global channel in unlicensed mode. These messages
continue to appear until you install version 7.0 or later of an NI ADE.

This section describes how to configure and use Traditional NI-DAQ
(Legacy) to control the SCXI-1540 in LabVIEW, LabWindows/CVI,
Measurement Studio, and other text-based ADEs. These NI ADEs provide
greater flexibility and access to more settings than MAX, but you can use
ADE:s in conjunction with MAX to quickly create a customized
application.

Traditional NI-DAQ (Legacy) in LabVIEW

SCXI-1540 User Manual

LabVIEW is a graphical programming environment for test and
measurement application development with built-in easy to use tools for
data acquisition, analysis, and display. Traditional NI-DAQ (Legacy)
provides several standard data acquisition subVlIs as well as subVIs
specifically for use with the SCXI-1540.

For applications using Traditional NI-DAQ (Legacy) in LabVIEW, there
are two typical methods of addressing SCXI-1540 channels—virtual
channels (specifically LVDT/RVDT virtual channels) and SCXI channel
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strings. Depending on the needs of your application, you choose one of
these channel addressing methods to use in your LabVIEW application.

The LVDT/RVDT virtual channel provides scaling for LVDT/RVDTs and
allows you to select any name for the SCXI-1540 LVDT/RVDT channel
that you choose without additional code. When you use virtual channels,
the maximum number of channels per E Series DAQ device is 512 in
multichassis systems. NI recommends using the LVDT/RVDT virtual
channel for ease of use. Refer to Appendix B, Using SCXI Channel Strings
with Traditional NI-DAQ (Legacy) 7.0 or Later, for more information on
how to create a LVDT/RVDT virtual channel.

The SCXI channel string allows you to combine large numbers of channels
into fewer scan list entries and to measure the signal voltage level directly
for custom scaling in your application. NI recommends using SCXI
channel strings for more advanced applications. In LabVIEW, an array of
these channel strings configures multiple modules for scanning. When
using SCXI channel strings, you can scan up to 3,072 channels in a
multichassis system using a single E Series DAQ device. Refer to
Appendix B, Using SCXI Channel Strings with Traditional NI-DAQ
(Legacy) 7.0 or Later, for more information about using SCXI channel
strings.

@ Note You cannot mix virtual channels with the SCXI channel strings within the same
channel string array.

To use virtual channels, enter the name of a virtual channel into the analog
input channel string. If using multiple virtual channels, enter them in a
different index in the channel string array, or separate them using a comma.

Since you can randomly scan analog input virtual channels, you can enter
the virtual channels you want to scan in any order or repeatedly in a channel
string array.
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Typical Program Flow

After you have determined how you want to address the channels and
whether you want to configure the SCXI-1540 in MAX or LabVIEW, you

can design your application using a typical program flow such as the one
shown in Figure 5-4.

Virtual Channel SCXI Channel String

Virtual Channel
or SCXI Channel

Configure

A Acquisition Settings

Create Virtual
Channel in MAX +
Configure
Mode Properties
|

\4
| Start Acquisition |

\ 4
| Take Measurements |

Continue
Sampling?

Scale, Analyze,
and Display

v

| Clear Acquisition I

| Error Handling |

Figure 5-4. Typical SCXI-1540 Program Flow with Traditional NI-DAQ (Legacy)
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Configure the SCXI-1540 Settings Using Traditional NI-DAQ (Legacy) in

LabVIEW

To configure and control the SCXI-1540 from LabVIEW, use the Al
Parameter VI. You can find Al Parameter VI in the function subpalette
Data Acquisition»Analog Input»Advanced Analog Input.

A parameter changed by the Al Parameter VI takes effect in hardware when
Al Start VI is called, not when Al Parameter VI is called. The Al parameter
VI merely changes the configuration in the driver memory. When called,
the Al Start VI reads the configuration settings in the driver memory and
then sends the actual control information to the SCXI-1540 module. A
setting established through Al Parameter VI is only valid for the LabVIEW
session and does not change the setting in MAX.

You can use the Al Parameter VI to configure the SCXI-1540 settings
shown in Table 5-3.

Table 5-3. Settings for Configuring the SCXI-1540 Through the Al Parameter

Software-
Configurable
Setting

Allowable Settings
AI Parameter VI (Float In, Boolean In, or Value In)
Parameter Name Data Type Values

Excitation Level

SCXI AC Voltage Excitation Float In (dbl) | 1.0, 3.0

Excitation SCXI AC Frequency Excitation | Float In (dbl) | 2500, 3300, 5000, 10000
Frequency
Connection Type | SCXI Connection Type Value In 4-Wire LVDT,

5-Wire LVDT
Synchronization | SCXI Synchronization Type Value In Internal Synchronization,
Type External Synchronization

© National Instruments
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An example of using the AI Parameter VI to control an SCXI-1540 is
shown in Figure 5-5.

- — Allovaable oz valtage values: Allowable excitation frequency values:
input imits [no change] 1.0, 3.0 2500.0, 3300.0,5000.0,10000.0
excitation voltage (RMS
channels [0 = r
[1/0
device [1 Al Pararn Fararmn
CONFIG _’\J'E! _‘\{.
S0l AC Voltage Excitation ] S0l AL Frequency Excitation =]
[20] [21]

Allowable connection types:
Awine LYDT, B-wfie LVDT

Allowable connection types:
Internal Sypnchronization, External Spnchronization

Afire LVDT =) Intemal Synchronization =)
[12] [14]
Patam Faram ECan rate| A
St v—— Set v START
| ~8 = W A -]

S0l Connection Type ¥| 50l Synchronization Tvpe ]

[13] 22]

aveform Graphi

[T} 1]
READ CLEAR
f\,‘* W =

timeout 7
-------

[time-out error code] [10800

Figure 5-5. Using the Al Parameter VI to Set Up the SCXI-1540
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Configure, Start Acquisition, and Take Readings Using Traditional
NI-DAQ (Legacy) in LabVIEW

After you have configured the SCXI-1540 settings for your application,
you can use the intermediate analog input functions Al Config VI, Al Start
VI, Al Read VI, and AI Clear VI to create your data acquisition application.
You can find the intermediate data acquisition Traditional NI-DAQ
(Legacy) functions in the function subpalettes Data Acquisition»
Analog Input. NI recommends using the intermediate analog input
functions for most SCXI-1540 applications. For more information about
using the intermediate data acquisition Traditional NI-DAQ (Legacy)
functions, refer to the LabVIEW Measurements Manual. You also can use
the LabVIEW Help for more detailed information about the various inputs
and outputs of these functions.

Analyze and Display Using Traditional NI-DAQ (Legacy) in LabVIEW

In LabVIEW, you can easily analyze SCXI-1540 measurements with a
variety of powerful analysis functions that you can find in the function
subpalettes Analyze»Waveform Conditioning and Analyze»

Signal Processing. You can perform post acquisition processing such as
waveform comparisons, harmonic analysis, and digital filtering. For more
information about these VIs, refer to the LabVIEW Analysis Concepts
manual. You also can use the LabVIEW Help for more detailed information
about how to use the analysis VIs.

In LabVIEW, you also can easily display SCXI-1540 measurements with a
variety of graphical waveform graphs, numeric slides, gauges, and other
indicators. You can find useful graphical controls and indicators for user
interaction with your application in the controls subpalettes. For more
information about these VlIs, refer to the LabVIEW User Manual. You also
can use the LabVIEW Help for more detailed information about how to use
graphical controls and indicators in your application.

Traditional NI-DAQ (Legacy) in Text-Based ADEs

© National Instruments

NI text-based ADEs, such as LabWindows/CVI, Measurement Studio for
Microsoft Visual Basic, and Measurement Studio for Microsoft Visual
C++, offer help in the development of test and measurement applications.
These ADEs provide easy data acquisition, data analysis, graphical display,
and data logging tools. Refer to the ADE user manual for more information
about how to use these features.

The high-level data acquisition tools provided in LabWindows/CVI and
Measurement Studio allow you to easily use virtual channels configured in
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MAX providing easy configuration and programming of the data
acquisition systems. However, some of the more advanced features of the
SCXI-1540 are not accessible through this easy-to-use API. For more
advanced features or for more explicit control of the programmatic
attributes, use the low-level DAQ functions provided in the Traditional
NI-DAQ (Legacy) C APIL. Refer to the ADE user documentation for more
information about how to use the high-level data acquisition tools that are
provided in your NI ADE.

For more advanced SCXI-1540 applications, or if you are using an ADE
other than an NI ADE, you can use the Traditional NI-DAQ (Legacy) C API
to call functions from the DAQ driver dynamically linked library (dll).
The C and Low-Level DAQ Functions section outlines the steps for
programming with the low-level DAQ function calls. If you are using
LabWindows/CVI or Measurement Studio, you also can write advanced
applications using the same low-level DAQ functions guidelines.

Configuring System Settings Using Traditional NI-DAQ (Legacy) C API

SCXI-1540 User Manual

Start the configuration of the acquisition by ensuring that the SCXI-1540
module and SCXI chassis are in their default states, and that the driver
software configuration matches the states the actual physical hardware
configuration. After setting the hardware and software to the defaults of
the module(s), you can configure any module settings that vary from the
default configuration settings. You also should configure the acquisition
parameters using the functions in Table 5-4. For additional information
such as the function prototypes, parameters, and usage instructions for each
function, refer to the Traditional NI-DAQ (Legacy) C Function Reference
Help installed by default in Start»Programs»National Instruments»
NI-DAQ.
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Table 5-4. Configuration Functions

Function Description

SCXI_Reset Resets the hardware such as the specified module to its default state.
You also can use SCXI_Reset toreset the SCXI chassis Slot 0 scanning
circuitry or reset the entire chassis.

The SCXI-1540 default conditions are:
* Gainsetat0.8

e 3V, excitation level

* 10 kHz excitation frequency

e External synchronization off

e 4-wire mode

SCXI_Load_Config Loads the SCXI chassis configuration information you established in
MAX. Sets the software states of the chassis and the modules present to
their default states. This function makes no changes to the hardware
state of the SCXI chassis or modules. It is possible to programmatically
change the configuration you established in MAX using the
SCXI_Set_Config function.

SCXI_SCAN_Setup Initializes multiplexing circuitry for a scanned data acquisition
operation. Initialization includes storing a table of the channel sequence
and gain setting for each channel to be digitized (MIO and Al devices
only). You cannot repeat channels or use nonsequential channels when
using the SCXI_SCAN_Setup function.

SCXI_MuxCtr_Setup Programs the E Series DAQ device with the correct number of channels
multiplexed per scan. This number must match the total number of
channels programmed in SCXI_SCAN_Setup.

E Note NI strongly recommends monitoring the built-in error status of each NI-DAQ
function. The NI-DAQ C API provides the NIDAQErrorHandler function, which ensures
that a specified NI-DAQ function executed properly, and assists in handling error messages
and reporting.
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Configure Module Settings Using Traditional NI-DAQ (Legacy) C API

After configuring the hardware for acquisition, you must load the various
channel attributes such as filter, gain, and excitation appropriate for your
application explicitly using the NI-DAQ function calls shown in Table 5-5.
For more information regarding each setting, refer to the Traditional
NI-DAQ (Legacy) C Function Reference Help installed by default in
Start»Programs»National Instruments»NI-DAQ.

Table 5-5. NI-DAQ Functions Used to Configure SCXI-1540

Channel Significant Possible
Setting NI-DAQ Function to Use Parameters Parameters Values
Connection SCXI_Configure_Connection | il6 0—Four-wire
Type connectionType connection
1—Five-wire
connection
2—Disable external
synchronization
3—Enable external
synchronization
Excitation SCXI_Set_Excitation il6 0—AC voltage
Voltage excitationType specified in units of
(type of excitation Vims
to set) 1.0,3.0
32
excitationvalue
(new value for the
specified excitation
parameter)
Excitation SCXI_Set_Excitation 16 1—AC frequency
Voltage excitationType specified in units of
(type of excitation Hz
to set 2500, 3300, 5000,
32 10000
excitationvalue
(new value for the
specified excitation
parameter)
SCXI-1540 User Manual 5-22 ni.com
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Perform Acquisition Using Traditional NI-DAQ (Legacy) C API

There are several NI-DAQ functions you can use to take measurements.
Usually in SCXI the preference is to take multiple samples from multiple
channels using the SCAN_Op function. SCAN_0Op performs a synchronous,
multiple-channel scanned data acquisition operation. SCAN_Op does not
return until Traditional NI-DAQ (Legacy) acquires all the data or an
acquisition error occurs. For this reason, it is sometimes useful to use
SCAN_Op in conjunction with the function Timeout_Config, which
establishes a timeout limit synchronous functions to ensure that these
functions eventually return control to your application. After acquiring data
using SCAN_Op, the resultant data is not organized by channel, so you
should demultiplex the data using SCAN_Demux. SCAN_Demux rearranges,
or demultiplexes, data acquired by a SCAN_Op into row-major order,
meaning each row of the array holding the data corresponds to a scanned
channel for easier access by C applications. BASIC applications need not
call SCAN_Demux to rearrange two-dimensional arrays since these arrays
are accessed in column-major order. For more information regarding each
acquisition function, refer to the Traditional NI-DAQ (Legacy) Function
Reference Help installed by default in Start»Programs»National
Instruments»NI-DAQ.

@ Note To synchronize multiple channels, you must make the connections shown in
Figure 2-4 and configure the slaved channels as externally synchronized. Do this
through MAX or by using the NI-DAQ function SCXI_Configure_Connection. You
must not configure the channel that originates the synchronization signal from its EX+ pin
for external synchronization since that channel serves as master and is not slaved to any
other channel.

Perform Scaling, Analysis, and Display

After acquiring raw voltage data from the acquisition functions, most
applications require adjustment by device calibration constants for
accuracy, scaling measured voltage, analysis, and graphical display.

The SCXI-1540 has stored software calibration constants loaded on the
module EEPROM that are used to achieve the absolute accuracy
specifications. SCXI_Scale scales an array of binary data acquired from
an SCXI channel to voltage using the stored software calibration constants
when it scales the data. You must call SCAN_Demux before SCXI_Scale if
you have multiple channels in the scan. For more information regarding
SCXI_Scale, refer to the Traditional NI-DAQ (Legacy) Function
Reference Help installed by default in Start»Programs»National
Instruments»NI-DAQ. NI-ADEs provide many powerful analysis
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functions to perform digital filtering, harmonic analysis, averaging, and
complex mathematics on measurements.

After performing scaling and analysis on the acquired data, you can display
the measurements in several ways. You can use any built in GUI tools in
your ADE. NI ADEs provide many graphical controls and indicators such
as charts, graphs, gauges, slides, and plots that you can use to display

the data. There is also a built in function, found in nidagex.h, called
NIDAQPlotWaveform that you can use to generate a simple plot of the
data.

Other Application Documentation and Material

This section provides information about multiplexed scanning and the
Traditional NI-DAQ (Legacy) examples for Measurement Studio and
LabWindows/CVI. Refer to the ADE manual and the DAQ analog input
examples that come with your application software for more detailed
information on programming the SCXI modules for scanning in
multiplexed mode.

Using Software for Multiplexed Scanning
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Performing scanning operations in software depends on the ADE

you are using. While using LabVIEW or Visual Basic 6, all scanning
operations are prepared in software by using an SCXI channel string as the
input to the channel parameter in the analog input VI or function. These
ADE:s also support virtual channels using Data Neighborhood (DAQ
Channel Wizard) in MAX. In LabWindows/CVI, C, or C++ development
environments, you need to make several NI-DAQ function calls to set up
each module involved in the scan, the chassis, and the E Series DAQ device
controlling the scan.

A discussion describing how to implement multiplexed scanning in the
different ADEs follows. Refer to the ADE manual and the DAQ analog
input examples that come with your application software for more detailed
information on programming your SCXI modules for scanning in
multiplexed mode.

LabVIEW and the SCXI Channel String

For LabVIEW and Visual Basic 6, the channel string determines the
sequence in which SCXI channels are scanned. Refer to Appendix B,
Using SCXI Channel Strings with Traditional NI-DAQ (Legacy) 7.0 or
Later, for more information about using SCXI channels strings in
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Traditional NI-DAQ (Legacy). In LabVIEW, an array of these channel
strings configures multiple modules in the scan list. When the application
program runs, the channel string is used for programming the channel
information into the SCXI system. The format of the channel string is as
follows:

obx ! scy ! mdz ! channels

where

obx is the onboard E Series DAQ device channel, with x representing
a particular channel where the multiplexed channels are sent. This
value is 0 for DAQ channel O in a single-chassis system. In a
multichassis or remote chassis system, however, the E Series DAQ
device channel x corresponds to chassis number n — 1, where E Series
DAQ device channel x is used for scanning the nth chassis in the
system.

scy is the SCXI chassis ID, where y is the number you chose when
configuring your chassis.

mdz is the slot position where the module is located, with z being the
particular slot number. The slots in a chassis are numbered from left to
right, starting with 1.

@ Note The obx ! specifier is optional and causes the gains on the module and E Series DAQ
device to be automatically set to fit the input limits parameter. When this specifier is
omitted, the default gain on the E Series DAQ device, usually the lowest gain, is used, but
the SCXI-1540 gain is adjusted to fit the input limits.

The last parameter, channels, is the list of channels that are scanned for
module z. It can have several formats:

* obx ! scy ! mdz ! n,wheren is a single input channel.

* obx ! scy ! mdz ! nl:n2, where nl and n2 represent a sequential
list of input channels, inclusive.

e obx ! scy ! mdz ! (nl,n2,n3:n4, nl, n5, n2), where nl, n2, and
n5 represent single channels, not necessarily sequential, and n3 and n4
represent the endpoints of a sequential list of channels, inclusive. In
this case, channels nl and n2 have explicitly been repeated in the
channel list.

@ Note Repeating channels or having channels out of sequence in a scan list is not supported
on all SCXI modules. Please refer to the manual of each module for information on this
feature.
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LabVIEW and the Virtual Channel String

For LabVIEW and Visual Basic 6, the channel string can also contain
virtual channels. For the SCXI-1540, these virtual channels are analog
input channels you create that have custom names, that perform all error
correction and scaling without additional code. Virtual channels are
particularly useful when sensors requiring different scaling factors are used
on the same SCXI-1540 channel. Using virtual channels, you can use
sensors needing special scaling in a generic analog input application
without performing hard-coded scaling. If you change the scaling or want
to connect a different sensor to your SCXI-1540, no changes are needed in
the application. All that is required is creating a different virtual channel
and using its name in the channel string.

@ Note You cannot mix virtual channels with the SCXI channel strings shown in the
previous section.

To create a virtual channel for the SCXI-1540, insert a new analog input
channel in the Data Neighborhood path in MAX, name it, and then follow
the software prompts to create virtual position channels, voltage channels,
or customized analog input channels. For more information on virtual
channels, consult the MAX online help file.

To use virtual channels, enter the name of a virtual channel into the analog
input channel string. If using multiple virtual channels, separate them using
a comma, or enter them in a different index in the channel string array. All
scaling is done automatically by the application.

E Note Since you can randomly scan virtual analog input channels, you can enter virtual
channels in any order or repeatedly in the channel string.

Performing a Multiplexed Scan
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To perform a multiplexed scan in your application, complete the following
steps:

1. Open an analog input example in your ADE.

2. Enter the appropriate SCXI channel string or virtual channel string into
the channels parameter.

3. Either enter the input limits for signals connected to your module to
adjust the gain settings in your system or use the default gain settings
from the configuration utility, and then run the application. When
using virtual channels, the default input limits configured in the virtual
channel configurator are used.
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You have completed a multiplexed scan using your SCXI-1540.

This is not a comprehensive discussion of SCXI scanning using LabVIEW
and Visual Basic, but this should give you enough information to help you
get started with the examples shipped with these software packages.

C and Low-Level DAQ Functions

When using a C-based environment, you need to take several steps to
configure the SCXI-1540 for multiplexed scanning. The following
procedure outlines the steps for programming with the low-level NI-DAQ
function calls:

1. Prepare your SCXI-1540 settings either by loading the original SCXI
configuration settings using SCXI_Load_Config, or by specifying all
configuration settings using the NI-DAQ function calls in Table 5-6.

Table 5-6. NI-DAQ Functions Used to Configure SCXI-1540

Channel Setting NI-DAQ Function to Use
Gain SCXI_Set_Gain
Excitation Frequency SCXI_Set_Excitation
Excitation Level SCXI_Set_Excitation
Wire Mode (4-Wire or 5-Wire) SCXI_Configure_Connection
Enable External Synchronization SCXI_Configure_Connection

2. Specify the module scan list, the start channel of each module, and the
number of channels to scan on each module with the function
SCXI_SCAN_Setup. This function accepts an array of start channels
and an array of the number of channels to scan in each module.
Therefore, it is not possible to repeat channels or use nonsequential
channels using this function.

3. Use SCXI_MuxCtr_Setup to program the E Series DAQ device with
the correct number of channels multiplexed per scan. This number
must match the total number of channels programmed in step 2.

You are now ready to acquire the channel data with the E Series DAQ
device. If you are using a multifunction E Series DAQ device, you can use
SCAN_Op to perform the scanning operation. After scanning, convert the
binary data to voltage data using SCXI_Scale. Refer to the Traditional
NI-DAQ (Legacy) User Manual for additional information on scanning
with E Series DAQ devices.
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Traditional NI-DAQ (Legacy) CVI Examples

Many example programs ship with NI-DAQ. For more example
information on how to create tasks and channels, refer to the example
programs. By default, the example programs are installed in C: \Program
Files\NationalInstruments\CVI 8.x\Samples. More examples
are installed by default in C: \Program Files\National
Instruments\NI-DAQ\Examples.

Traditional NI-DAQ (Legacy) Measurement Studio Examples

Calibration

Many example programs ship with NI-DAQ. For more example
information on how to create tasks and channels, refer to the example
programs. By default, the example programs are installed in C: \Program
Files\NationalInstruments\Measurement Studio 7.0.More
examples are installed by default in C:\Program Files\National
Instruments\NI-DAQ\Examples.

The SCXI-1540 is shipped with a calibration certificate and is calibrated at
the factory to the specifications described in Appendix A, Specifications.
Calibration constants are stored inside the calibration EEPROM and
provide software correction values your application development software
uses to correct your measurements for both offset and gain errors in the
module.

You may want to periodically calibrate the module for offset and gain drift
using the procedures described in the Calibration Procedures section.

Calibration Procedures

You can calibrate the offset and gain on the SCXI-1540 using National
Instruments software. The SCXI-1540 provides input switching that
automatically connects the input terminals to the excitation terminals when
you perform a calibration. There is generally no need to change the input
wiring since this connection is made internally and the front panel input
signal terminals are disconnected. The excitation terminals remain
connected to the front panel. This causes no problems during calibration
provided there is no wiring error that might short-circuit the excitation
signal.

Caution Ensure the calibration on the DAQ device or DMM you are using is current
and traceable. If you modify the gain and offset software-correction values using an
uncalibrated device, your calibration is not valid, or your calibration is not traceable.

SCXI-1540 User Manual
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Calibration Using LabVIEW or a C-Based ADE

You can use the LabVIEW SCXI Calibrate VI or the NI-DAQ function
SCXI_calibrate to calibrate your SCXI-1540. These functions calibrate
all channels for all gains and excitation levels when called.

If you are using external synchronization, National Instruments
recommends that you perform a calibration with the synchronization
wiring and synchronization configuration settings in place. Excitation
levels and frequencies are affected slightly by synchronization which,
in turn, slightly effects the calibration.

If you are using LabVIEW, use the following procedure:

1. Make sure the E/M Series DAQ device or DMM you are using has
a valid calibration.

2. Use the LabVIEW function SCXI Calibrate VI to calibrate your
module.

a. Enter the E/M Series DAQ device and the SCXI channel string for
all eight channels. For example, your channel string might be
ob0 ! scl ! md3 ! 0:7.

b. Select internal calibration as the calibration operation you are
going to perform.

c. Select the Default EEPROM load area as the area you want to
update.

If you are using a C-based ADE, use the following procedure:

1. Make sure the E/M Series DAQ device or DMM you are using has a
valid calibration and meets the accuracy specifications for your
application.

2. Use the NI-DAQ function, SCXI_Calibrate.

a. Enter the E/M Series DAQ device, DAQ channel, and module slot.
You need not enter a channel number since SCXI_Calibrate
automatically calibrates all channels of the SCXI-1540.

b. Select internal calibration (0) as the operation you are going to
perform.

c. Select the load area (1) as the EEPROM area you want to update.

The SCXI-1540 takes a few seconds to perform the calibration. After
completion, your module has new calibration constants stored for all
channels, gains, and excitation settings.
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Specifications

This appendix lists the specifications for the SCXI-1540 modules. These
specifications are typical at 25 °C unless otherwise noted.

General Specifications

Table A-1. Input Range, Gain, and Required E/M Series DAQ Device Input Limits

Full-Scale Voltage
Input Range (used in calculating Accuracy, refer to Gain Setting E/M Series DAQ Device
(Vims) the Absolute Accuracy section) (VDC out/V s in) Input Limits (V)
6.0 6.0 0.8 +5.0
5.5 55 0.9 +5.0
5.0 5.0 1.0 +5.0
45 4.5 1.1 +5.0
4.0 4.0 1.25 +5.0
35 3.5 1.4 +5.0
3.0 3.0 1.6 +5.0
2.7 2.7 1.8 +5.0
2.5 2.5 2.0 +5.0
2.2 22 22 +5.0
2.0 2.0 2.5 +5.0
1.7 1.7 2.8 +5.0
1.5 1.5 32 +5.0
1.35 1.35 3.6 +5.0
1.25 1.25 4.0 +5.0
1.10 1.10 4.5 +5.0
1.00 1.00 5.0 +5.0
0.85 0.85 5.6 +5.0

© National Instruments
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Table A-1. Input Range, Gain, and Required E/M Series DAQ Device Input Limits (Continued)

0.05% of full scale typ

OULPUL TANZE ..evvvenereereeieeieeiee e 5.0V

I When using external synchronization, the SCXI-1540 only supports input excitation sources that are supplied by the

SCXI-1540.
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Full-Scale Voltage
Input Range | (used in calculating Accuracy, refer to Gain Setting E/M Series DAQ Device
(Vims) the Absolute Accuracy section) (VDC out/V s in) Input Limits (V)

0.75 0.75 6.3 +5.0

0.70 0.70 7.0 +5.0

0.62 0.62 8.0 +5.0

0.55 0.55 9.0 +5.0

0.50 0.50 10.0 +5.0

0.45 0.45 11.0 +5.0

0.40 0.40 12.5 +5.0

0.35 0.35 14.0 +5.0

0.31 0.31 16.0 +5.0

0.27 0.27 18.0 +5.0

0.25 0.25 20.0 +5.0

0.22 0.22 22.0 +5.0

0.20 0.20 25.0 +5.0

0.10 0.20 25.0 +2.5

0.05 0.20 25.0 +1.0
Input impedance .........c..cccceeeeeenenciennnnne 100 kQ +2%
Frequency response ..........cccevveeveeenneenne 250 Hz LPF, 4-pole Butterworth
Input connections...........ceeeveeveenieniennenne 4-wire or 5-wire
Synchronization ..........cceceeeveenveeveenneenne Internal or external!
Residual ripple and noise..........ccccceueeneee <0.1% peak of full scale
NONINEATILY ..covvenveeieieeieieeienieeeeieeene <0.1% of full scale max

ni.com
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Output offset drift.........cceceevverreennennnen. +70 uV/°C max
Input gain ......coeveeviiniiiiieicieee Refer to Table A-1
Input gain accuracyl.......cccooveveeinnnnnen. +2%
Gain drift.....coceeveeniiiieeeceeee +300 ppm/°C max
Input damage level,
power on or Off........cccooeiviiniinniiininnen, 32 Vims
Excitation
Frequency.......cccoceecveviniicnincnnnnne. 2.5 kHz +10%
3.3kHz +10%
5.0 kHz +10%
10.0 kHz £10%
Level
Low setting!..........cccoeveverennes 1 Ve 5%
High setting! ........cccovvveveiinnnes 3 Vs £5%
Minimum load impedance....... 32 Q for 1 V, setting

95 Q for 3 V,, setting

! This is the error before correction in software. Input gain error, excitation level error, and output offset error are accounted for
in the software correction coefficients stored in the onboard EEPROM. These constants are applied automatically when using
NI-DAQmx tasks or Traditional DAQ (Legacy) virtual channels. The specifications in the Absolute Accuracy section indicate
overall accuracy of the SCXI-1540, including the application of the software correction coefficients.
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Absolute Accuracy

Absolute accuracy includes the cumulative error of both excitation and
input gain after the application of software correction coefficients. The
software correction coefficients reside in the onboard EEPROM and are
applied automatically to acquired data when using NI-DAQmx tasks or
Traditional NI-DAQ (Legacy) virtual channels.

Table A-2. Absolute System Accuracy

System Noise
% of Reading Max (Peak, % of Full Scale) Temperature Drift

Exc. Offset
Freq (% of Full 100 Pt. Gain Drift Offset Drift
(kHz) Typical Max Scale) Single Pt. Avg. (°C) (°C)

2.5 +0.2% +0.5% +0.05% +0.03% +0.01% +0.03% +0.003%

33 +0.2% +0.5% +0.05% +0.03% +0.01% +0.03% +0.003%

5 +0.2% +0.5% +0.05% +0.03% +0.01% +0.03% +0.003%

10 +0.5% +1.0% +0.05% +0.03% +0.01% +0.03% +0.003%

Absolute accuracy is (voltage reading) X % of reading + (Full-Scale Voltage
from Table A-1) X (max offset) + (system noise X full-scale voltage). To
include the effects of temperature drift away from the temperature at which the
module was calibrated, add the term

(voltage reading) X (gain drift) X AT + (full-scale voltage X offset drift) x AT

where AT is temperature change. Scan rate for 100-point averages is
200 scans per second.

Power Requirements

Vb et 18.5 VDC to 25 VDC,
+170 mA min

Ve —18.5 VDC to -25 VDC,
—170 mA min

F5 Vs +4.75 VDC to 5.25 VDC,
50 mA min
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Physical

3.0cm
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Figure A-1. SCXI-1540 Dimensions
WeEIght..cuviiieiiiiiiiieceeceee 727 g (25.6 0z)

Maximum Working Voltage

Maximum working voltage refers to the signal voltage plus the
common-mode voltage.

Channel-to-earth..........cccceceevveereennennen. 6 Vs, Measurement Category [

Channel-to-channel ...........cccccoeveennenen. 6 V..., Measurement Category I
A Caution Do not use for measurements within Measurement Categories II, III, or I'V.

Caution The protection provided by the SCXI-1540 can be impaired if it is used in a
manner not described in this document.
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Environmental

Safety

Operating temperature ..........cc.cceeecvennene 0°Cto50°C

Storage temperature..............ccceeueerenneee -20°Cto 70 °C

Humidity ....ccooceviveniniiiicieiceecnceee 10% to 90% RH, noncondensing
Maximum altitude...........oooovvvevvvinnrnnnnns 2,000 m

Pollution Degree..........ccocveeveeenieenuenneennne 2

Indoor use only

This product is designed to meet the requirements of the following
standards of safety for electrical equipment for measurement, control,
and laboratory use:

« JEC61010-1, EN-61010-1
e UL 61010-1, 61010-1

@ Note For UL and other safety certifications, refer to the product label or visit ni . com/
certification, search by model number or product line, and click the appropriate link
in the Certification column.

Electromagnetic Compatibility

This product meets the requirements of the following EMC standards for
electrical equipment for measurement, control, and laboratory use:

e EN61326-1 (IEC 61326-1): Class A emissions; Basic immunity
e ENS55011 (CISPR 11): Group 1, Class A emissions

e AS/NZS CISPR 11: Group 1, Class A emissions

e FCC 47 CFR Part 15B: Class A emissions

e ICES-001: Class A emissions

@ Note In the United States (per FCC 47 CFR), Class A equipment is intended for use in
commercial, light-industrial, and heavy-industrial locations. In Europe, Canada, Australia
and New Zealand (per CISPR 11) Class A equipment is intended for use only in
heavy-industrial locations.

@ Note Group 1 equipment (per CISPR 11) is any industrial, scientific, or medical
equipment that does not intentionally generates radio frequency energy for the treatment
of material or inspection/analysis purposes.

SCXI-1540 User Manual
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@ Note For EMC declarations and certifications, and additional information, refer to the
Online Product Certification section.

CE Compliance C€

This product meets the essential requirements of applicable European
Directives, as amended for CE marking, as follows:

»  73/23/EEC; Low-Voltage Directive (safety)
*  89/336/EEC; Electromagnetic Compatibility Directive (EMC)

Online Product Certification

Refer to the product Declaration of Conformity (DoC) for additional
regulatory compliance information. To obtain product certifications and the
DoC for this product, visit ni.com/certification, search by model
number or product line, and click the appropriate link in the Certification
column.

Environmental Management

© National Instruments

NI is committed to designing and manufacturing products in an
environmentally responsible manner. NI recognizes that eliminating certain
hazardous substances from our products is beneficial to the environment
and to NI customers.

For additional environmental information, refer to the NI and the
Environment Web page atni . com/environment. This page contains the
environmental regulations and directives with which NI complies, as well
as other environmental information not included in this document.
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Waste Electrical and Electronic Equipment (WEEE)

E EU Customers At the end of the product life cycle, all products must be sent to a WEEE
- recycling center. For more information about WEEE recycling centers, National
Instruments WEEE initiatives, and compliance with WEEE Directive 2002/96/EC on

Waste and Electronic Equipment, visit ni . com/environment /weee.

BT ERFMmISERERERNZE (PE ROHS

=y
REZEF National Instruments 774 L5 8 b o BRI 284 Y 554 (ROHS).

KT National Instruments [ RoHS A #IPE(5 &, 5% 3% ni. com/environment /rohs_china.
(For information about China RoHS compliance, go fo ni.com/environment /rohs_china,)
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Using SCXI Channel Strings with
Traditional NI-DAQ (Legacy) 7.0
or Later

@ Note This appendix is not applicable if you use the virtual channels to configure and
measure the SCXI channels. Virtual channels are configured using MAX. If you use virtual
channels, you address the SCXI channels by specifying the channel name(s) in the channel
string input.

When using LabVIEW and Visual Basic 6, the SCXI channel string
determines which SCXI channels are scanned and the scanning sequence.
The SCXI channel string allows you to take measurements from several
channels on one module with only one channel string entry. An array of
these channel string entries configures multiple modules for scanning.
When the application program runs, the channel string is used

for programming the channel information into the SCXI system.

The format of the channel string is as follows:
obx ! scy ! mdz ! channels
where

obx is the onboard E Series DAQ device channel, with x representing a
particular channel where the multiplexed channels are sent. This value is
0 for E Series DAQ device channel 0 in a single-chassis system. In a
multichassis or remote chassis system, the E Series DAQ device channel x
corresponds to chassis number n — 1, where E Series DAQ device channel
x is used for scanning the nth chassis in the system.

scy is the SCXI chassis ID, where y is the number you chose when
configuring the chassis.

mdz is the slot position where the module is located, with z being the
particular slot number. The slots in a chassis are numbered from left to right
starting with 1.
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channels is the list of channels that are scanned for module z. It can have
several formats:

obx ! scy ! mdz ! nx, where nxis a single input channel.

obx ! scy ! mdz ! (n0, n2),where n0, n2areindividual input
channel that are not necessarily sequential.

obx ! scy ! mdz ! n0:n3,where n0and n3 represent an ascending
sequential list of input channels, inclusive.

obx ! scy ! mdz ! (n0O, n2, n3:n4, nl, n5, n2),where
n0, n2, and n5 represent single channels, not necessarily sequential,
and n3 and n4 represent the endpoints of an ascending sequential list
of channels, inclusive. In this case, channels n1 and n2 are explicitly
repeated in the channel list.

@ Note Using parenthesis surrounding multiple channels in a channel string is important for
correct scanning operation of the SCXI channels.

In a single-chassis system, the obx ! specifier is optional and causes the gains on the
module and E Series DAQ device to be automatically set to fit the input limits parameter.
When this specifier is omitted, the default gain on the E Series DAQ device, usually the
lowest gain, is used, but the SCXI-1540 gain is adjusted to fit the input limits.

NI recommends using the obx ! specifier.

Repeating channels or having channels out of sequence in a scan list is not supported on
all SCXI modules. Refer to the manual of each module for information on this feature,
which is referred to as flexible scanning or random scanning.

For more information about using SCXI channel string, refer to the

LabVIEW Measurements Manual and SCXI-1540 shipping examples.

Special SCXI-1540 Channel Strings

You can use the calibration ground channel string with the SCXI-1540 to
acquire signals from alternative locations rather than the signal inputs on
the channels. This section describes the use of these channels.

Calibration Ground Channel String

The SCXI-1540 has a special calibration feature that enables LabVIEW
to ground the module amplifier inputs so that you can read the amplifier
offset. For the other SCXI analog input modules, you must physically wire
the terminals to ground. The measured amplifier offset is for the entire
signal path including the SCXI module and the E Series DAQ device.

SCXI-1540 User Manual
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To read the grounded amplifier on the SCXI-1540 use the standard SCXI
string syntax in the channels array with calgndz substituted for the
channel number, where z is the appropriate SCXI channel needing
grounding.

For example, use the SCXI channel string ob0 ! scl ! mdl ! calgnd0
to read the grounded channel O signal of the module in slot 1 of SCXI

chassis 1. The resulting measurement should be very close to 0 V. The Al
Start VI grounds the amplifier before starting the acquisition. The Al Clear
VI removes the grounds from the amplifier after the acquisition completes.

You can specify a range of channels also. The string calgnd0:7 grounds
the amplifier inputs for channels O through 7 and reads the offset for each
amplifier.

Use the SCXI Calibrate VI, available on the Functions»Data Acquisition»
Calibration and Configuration palette, to automatically perform a self
calibration and modify the scaling constants on the module to adjust for any
amplifier offset. Refer to the Calibration Using LabVIEW or a C-Based
ADE section of Chapter 5, Using the SCXI-1540, for more information
about how to use SCXI Calibrate VI with the SCXI-1540.
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Removing the SCXI-1540

This appendix explains how to remove the SCXI-1540 from MAX and an
SCXI chassis or PXI/SCXI combination chassis.

Removing the SCXI-1540 from MAX

To remove a module from MAX, complete the following steps after
launching MAX:

1. Expand Devices and Interfaces.

2. Click the + next to NI-DAQmx and/or Traditional NI-DAQ Devices
to expand the list of installed chassis.

3. Click the + next to the appropriate chassis to expand the list of installed
modules.

4. Right-click the module or chassis you want to delete and click Delete.

A confirmation window opens. Click Yes to continue deleting the
module or chassis or No to cancel this action.

@ Note Deleting the SCXI chassis deletes all modules in the chassis. All configuration
information for these modules is also lost.

The SCXI chassis and/or SCXI module(s) should now be removed from the
list of installed devices in MAX.

Removing the SCXI-1540 from a Chassis

Consult the documentation for the chassis and accessories for additional
instructions and precautions. To remove the SCXI-1540 module from a
chassis, complete the following steps while referring to Figure C-1:

@ Note Figure C-1 shows an SCXI chassis, but the same steps are applicable to a PXI/SCXI
combination chassis.
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1. Power off the chassis. Do not remove the SCXI-1540 module from a
chassis that is powered on.

2. If the SCXI-1540 is the module cabled to the E/M Series DAQ device,
disconnect the cable.

Remove any terminal block that connects to the SCXI-1540.

4. Rotate the thumbscrews that secure the SCXI-1540 to the chassis
counterclockwise until they are loose, but do not completely remove
the thumbscrews.

Remove the SCXI-1540 by pulling steadily on both thumbscrews until the
module slides completely out.

1 Cable 4 LVDT Sensor 6 SCXI Chassis Power Switch
2 SCXI Module Thumbscrews 5 Terminal Block 7 SCXI Chassis
3 SCXI-1540

Figure C-1. Removing the SCXI-1540
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Common Questions

This appendix lists common questions related to the use of the SCXI-1540.

Which version of NI-DAQ works with the SCXI-1540 and how do I get
the most current version of NI-DAQ?

You must have NI-DAQ 7.0 or later. NI recommends using the latest
version of NI-DAQmx. Visit ni . com and follow the link, Drivers and
Updates»Current Software Versions»Multifunction DAQ to find the
latest version of NI-DAQ for your operating system.

I have gone over the Verifying and Self-Testing the Installation in
Chapter 1, About the SCXI-1540, yet 1 still cannot correctly test and
verify that my SCXI-1540 is working. What should I do now?

Unfortunately, there always exists the chance that one or more components
in your system are not operating correctly. You may have to call or e-mail
a technical support representative. The technical support representative will
often suggest additional troubleshooting measures. If requesting technical
support by phone, have your system nearby so you can try these measures
immediately.

Can I use the unused analog input channels of the E/M Series DAQ
device if I am directly cabled to the SCXI-1540?

No. E/M Series DAQ device channels 1 through 7 connect to the
conditioned analog outputs of SCXI-1540 channels 1 through 7.
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Common Questions

Which digital lines are unavailable on the E/M Series DAQ device if I
am cabled to an SCXI-1540 module?

Table D-1 shows the digital lines that are used by the SCXI-1540
for communication and scanning. These lines are unavailable for
general-purpose digital I/O if the SCXI-1540 is connected to the
E/M Series DAQ device.

Table D-1. Digital Signals on the SCXI-1540

Direction
(with respect
to the E'M
DAQ SCXI 50-Pin 68-Pin Series DAQ
Signal Name Signal Name Connector Connector device)
P0.0 SERDATIN 25 52 Output
P0.4 SERDATOUT 26 19 Input
PO.1 DAQD*/A 27 17 Output
P0.2 SLOTOSEL* 29 49 Output
AT HOLD COMP, | SCANCLK 36 46 Output
AI HOLD
EXT SROBE* SERCLK 37 45 Output
AI SAMP CLK, SYNC* 46 38 Output
Al SAMP

SCXI-1540 User Manual

In LabVIEW, can I use different input limits for the same SCXI-1540
channel if I repeat the channel in the SCXI channel string array?

No. The SCXI-1540 cannot dynamically change the gain settings during
scanning. Therefore, group channels with similar input ranges together in
the channel string array. Make sure that repeated channels in different
indices of the channel string array have the same input limits in the
corresponding input limits array.

In NI-DAQmx, can I use a VI to change my SCXI-1540 configuration
settings?

Yes. You can use the DAQmx Property Node to change all the SCXI-1540
configuration settings.
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Are there any cabling restrictions when using an SCXI-1540 module
with a plug-in E/M Series DAQ device?

Refer to the SCXI Quick Start Guide to determine which module to use as
the cabled module. A cabled module is the module connected directly to the
E/M Series DAQ device. This ensures that a timing signal (from GPCTRO
on the E/M Series DAQ device) is available for use by all
simultaneous-sampling SCXI modules in the chassis.

Can I use the SCXI-1540 with a version of NI-DAQ that works under
the Macintosh Operating System (MacOS)?

No.

Some SCXI modules permit random scanning. Does the SCXI-1540
module permit random scanning?

Yes. Random scanning is described in Chapter 2, Connecting Signals.

What is the power-up state of the SCXI-1540 multiplexer, analog bus
switches, and configuration settings?

The multiplexer, analog bus switches, and configuration settings are not in
a known state immediately after power on. All hardware settings are
programmed automatically when beginning an acquisition in LabVIEW.

Which accessories can I use to connect signals to the front of the
SCXI1-1540 module?

Refer to Chapter 1, About the SCXI-1540, for more information.

How do I calculate the maximum permitted scan rate when using one
or more SCXI-1540 modules in multiplexed mode?

For the SCXI-1540 and most other SCXI modules, the maximum scan rate
is limited to a 333 kS/s/(number of scanned channels) if the controlling
E/M Series DAQ device is not the limiting factor.
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How do I control the gain, frequency, excitation level, wire mode, and
synchronization in LabVIEW?

You can create and save a DAQmx task in Max or programmatically in
LabVIEW using DAQmx API VIs.

The gain of each SCXI-1540 channel is automatically set based on the
channel limits used in setting up the task.

Frequency, excitation level, wire mode, and synchronization mode are also
properties of the task that you can set or edit using DAQmx Property Nodes.

How do I control the gain, frequency, excitation level, wire mode, and
synchronization in C-based application environments?

You must use the NI-DAQ functions listed in Table 5-5, NI-DAQ Functions
Used to Configure SCXI-1540.
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Glossary

Symbol Prefix Value

p pico 10-12
n nano 10-°
n micro 10-¢
m milli 10-3
k kilo 103

Numbers/Symbols

% percent

/ per

° degrees

Q ohms

+5 V (signal) +5 VDC source signal

A

A amperes

absolute accuracy the maximum difference between the measured value from a data

acquisition device and the true voltage applied to the input, typically
specified as + voltage

AC alternating current

ADE application development environment such as LabVIEW,
LabWindows/CV], Visual Basic 6, C, and C++

Al HOLD COMP, scan clock signal used to increment to the next channel after each
AT HOLD E/M Series DAQ device analog-to-digital conversion
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Glossary

C

C
CE
CHx-
CHx +

crosstalk

DAQ

DAQ device

DC
DIGGND
DIN

DIO

DMM

E

EEPROM

EMC

SCXI-1540 User Manual

Celsius

European emissions control standard
negative input terminal for channel x
positive input terminal for channel x

an unwanted signal on one channel due to an input signal on a different
channel

data acquisition—(1) collecting and measuring electrical signals from
sensors, transducers, and test probes or fixtures and processing the
measurement data using a computer; (2) collecting and measuring the same
kinds of electrical signals with A/D and/or DIO boards plugged into a
computer, and possibly generating control signals with D/A and/or DIO
boards in the same computer

a data acquisition device. Examples are DIO and E/M Series MIO data
acquisition devices.

direct current

digital ground signal

Deutsche Industrie Norme (German Industrial Standard)
digital input/output

digital multimeter

electrically erasable programmable read-only memory—ROM that can be
erased with an electrical signal and reprogrammed. Some SCXI modules
contain an EEPROM to store measurement-correction coefficients.

electromagnetic compliance
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EMI
EX-

EX+

gain
gain accuracy

gain error

I/0

in.

input impedance

LPF

LVDT

© National Instruments

Glossary

electromagnetic interference
a negative excitation output terminal

a positive excitation output terminal

the factor by which a signal is amplified, sometimes expressed in decibels
a measure of deviation of the gain of an amplifier from the ideal gain

See gain accuracy.

hertz—cycles per second of a periodic signal; the unit of measure for
frequency

input/output—the transfer of data to/from a computer system involving
communications channels, operator interface devices, and/or data
acquisition and control interfaces

inch or inches

the measured resistance and capacitance between the input terminals of a
circuit

lowpass filter

linear variable differential transformer—a transformer-based sensor for
measuring linear displacement

G-3 SCXI-1540 User Manual



Glossary

m
mil
MIO

multiplexed mode

N
NI-DAQ

NI-DAQmx

noise

nonlinearity

NRSE

0

offset error
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meters
a unit of measure equal to 0.001 inch
multifunction I/O

an SCXI operating mode in which analog input channels are multiplexed
into one module output so that your cabled E/M Series DAQ device has
access to the module’s multiplexed output as well as the outputs of all other
multiplexed modules in the chassis that are coupled to the SCXIbus

National Instruments driver software for DAQ hardware

The latest NI-DAQ driver with new VIs, functions, and development tools
for controlling measurement devices.

an undesirable electrical signal—noise comes from external sources such
as AC power lines, motors, generators, transformers, fluorescent lights,
soldering irons, CRT displays, computers, electrical storms, welders, radio
transmitters, and internal sources such as semiconductors, resistors, and
capacitors; corrupts signals you are trying to measure.

for an amplifier, a measure of the maximum output deviation from an ideal
linear response in units of percent relative to full scale. The ideal linear
response is taken to be a straight line on a plot of measured output voltage
to measured input voltage with the ends of the line connecting the extremes
of the plot at the full-scale limits.

nonreferenced single-ended mode—all measurements are made with
respect to a common (NRSE) measurement system reference, but the
voltage at this reference can vary with respect to the measurement system
ground

the output of a system with a zero-volt input
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ppm
PXI

Q

quadrature encoder

R

resolver

rms

RSC
RSVD

RVDT

S/s

scan
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Glossary

parts per million

PCI eXtensions for Instrumentation—an open specification that builds on
the CompactPCI specification by adding instrumentation-specific features

A device that converts linear or rotary movement into electrical pulses on
two channels. The pulse stream of one channel either leads or lags the pulse
stream of the other channel depending on the direction of movement.

A transformer-based sensor for measuring absolute angular displacement
over 360°. Measurement is continuous for any number of revolutions. The
simultaneous conditioning of a sine and a cosine signal is required.

root mean square—the square root of the average value of the square of the
instantaneous signal amplitude; a measure of signal amplitude

rear signal connector
reserved bit, pin, or signal

rotary variable differential transformer—a transformer-based sensor for
measuring absolute angular displacement whose measurement range is
typically between £30° and +70° of rotation

seconds

samples per second—used to express the rate at which a E/M Series DAQ
device samples an analog signal

one or more analog samples taken at the same time, or nearly the same time.
Typically, the number of input samples in a scan is equal to the number of
channels in the input group. For example, one scan, acquires one new
sample from every analog input channel in the group.
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Glossary

scan rate

SCANCLK

SCXI

SCXIbus

sensitivity

SERDATOUT
signal conditioning
SYNC

system noise

T

Traditional NI-DAQ
(Legacy)

UL
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the number of scans a system takes during a given time period, usually
expressed in scans per second. For example, a scan rate of 10 Hz means
sampling each channel 10 times per second.

scan clock signal used to increment to the next channel after each
E/M Series DAQ device analog-to-digital conversion

Signal Conditioning eXtensions for Instrumentation—the National
Instruments product line for conditioning low-level signals within an
external chassis near sensors so only high-level signals are sent to
E/M Series DAQ devices in the noisy PC environment

located in the rear of an SCXI chassis, the SCXIbus is the backplane that
connects modules in the same chassis to each other

for an LVDT or RVDT, the ratio of output voltage change to input position
change for a primary excitation level of one volt rms

serial data output signal
the manipulation of signals to prepare them for digitizing
synchronization pulse for scanning

ameasure of the amount of noise seen by an analog circuit or an ADC when
the analog inputs are grounded

An upgrade to the earlier version of NI-DAQ. Traditional NI-DAQ
(Legacy) has the same VIs and functions and works the same way
as NI-DAQ 6.9.x. You can use both Traditional NI-DAQ (Legacy)
and NI-DAQmx on the same computer, which is not possible with
NI-DAQ 6.9.x.

Underwriters Laboratory
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VDC

VI

virtual channels

Vrms

]

working voltage
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Glossary

volts
volts direct current

virtual instrument—(1) a combination of hardware and/or software
elements, typically used with a PC, that has the functionality of a classic
stand-alone instrument; (2) a LabVIEW software module (VI), which
consists of a front panel user interface and a block diagram program

channel names that can be defined outside the application and used without
having to perform scaling operations

volts, root mean square

the highest voltage with respect to ground that should be applied to an input
terminal during normal use, normally well under the breakdown voltage for
safety margin. Includes both the signal and common-mode voltages.
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Index

A

accessories for connecting signals, D-3
accuracy, absolute, A-4
table, A-4

C

C language and low-level DAQ functions, 5-27
calibration
procedures, 5-28
using LabVIEW or C-based ADE, 5-29
channel scanning. See multiplexed scanning
channel synchronization, 2-3
common questions, D-1
configuration
common questions, D-1
excitation
frequency, 3-2
level, 3-2
external synchronization, 3-2
gain setting, 3-1
troubleshooting self-test verification, 1-6
wire mode, 3-2
connecting
SCXI-1540 and resolvers, 2-4
connecting SCXI-1540 to DAQ device. See
DAQ devices
connectors
front signal connector
pin assignments (table), 2-6
rear signal connector
overview, 2-7
conventions used in the manual, iv

© National Instruments I-1

D

DAQ device
cabling restrictions with plug-in E/M
Series DAQ device, D-3
low-level DAQ functions and multiplexed
scanning, 5-27
required limits, input range, and gain
(table), A-1
unavailable digital lines, D-2
DAQ devices
connecting to SCXI-1540 for multiplexed
scanning
in PXI/SCXI combination
chassis, 1-5
in SCXI chassis, 1-5
digital signals
SCXI-1540 (table), D-2
unavailable with DAQ device connected
(table), D-2
documentation, conventions used in the
manual, iv

E

E Series DAQ device, cabling restrictions, D-3
electromagnetic compatibility, A-6
environmental specifications, A-6
excitation

frequency, setting, 3-2

level, setting, 3-2
external synchronization, setting, 3-2

F

frequency, excitation, 3-2
front signal connector
pin assignments (figure), 2-6
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Index

G

gain, setting, 3-1

installation
connecting to DAQ device for
multiplexed scanning
in PXI/SCXI combination
chassis, 1-5
in SCXI chassis, 1-5
into SCXI chassis, 1-4
installing and configuring the SCXI-1540, 1-1

L

LabVIEW

calibration procedure, 5-29

changing configuration settings, D-2

input limits, D-2

SCXI channel string, 5-24

synchronization, D-4

virtual channel string, 5-26
low-level DAQ functions

in multiplexed scanning, 5-27
LVDTs (linear variable differential

transformers), 4-1
core locations with resulting induced
voltage and phase (figure), 4-3

cut-away view (figure), 4-1

description, 4-1

scaling data in multiplexed scanning, 4-8

signal connections

4-wire (figure), 2-1
5-wire (figure), 2-2
use of, 4-4
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Measurement & Automation Explorer
removing the SCXI-1540, C-1
self-test verification
troubleshooting, 1-6
virtual channels, 5-24
multiple channel synchronization (figure), 2-3
multiplexed mode operation
connecting to SCXI-1540 for DAQ device
in PXI/SCXI combination, 1-5
in SCXI chassis, 1-5
multiplexed scanning
calculating maximum permitted scan
rate, D-3
channel scanning, 5-24
LabVIEW
SCXI channel string, 5-24
virtual channel string, 5-26
low-level DAQ functions, 5-27
performing scans
C and low-level DAQ functions, 5-27
converting resolver data to angular
position, 4-8
scaling LVDT and RVDT data, 4-8
steps, 5-26
using software, 5-24
SCXI-1540, D-3

NI-DAQ software
and MacOS, D-3
functions used to configure SCXI-1540
(table), 5-27
version required, D-1
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P
physical specifications, A-5
pin assignments, 2-5

front signal connector (table), 2-6
power requirements, A-4
power-up state of SCXI-1540, D-3
PXI/SCXI combination chassis, 1-5

Q

questions and answers, D-1

R

random scanning, 4-6
rear signal connector, 2-7
removing the SCXI-1540
from Measurement & Automation
Explorer, C-1
resolver connection (figure), 2-4
resolvers, 4-1
converting resolver data to angular
position, 4-8
defined, 4-4
signal connections, 2-4
RVDTs (rotary variable differential
transformers), 4-1
defined, 4-4
scaling data in multiplexed scanning, 4-8
signal connections
4-wire (figure), 2-1
5-wire (figure), 2-2

S

SCXI channel string
See also multiplexed scanning
defined, 5-24
LabVIEW channel scanning, 5-24
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Index

SCXI chassis
connecting SCXI-1540 to DAQ
device, 1-5
SCXI-1540
accessories for connecting signals, D-3
block diagram (figure), 4-5
cabling restrictions with plug-in E/M
Series DAQ device, D-3
calibration, 5-28
common questions, D-1
configuring, with NI-DAQ functions
(table), 5-27
connectors, rear signal connector, 2-7
digital signals (table), D-2
LVDTs, RVDTs, and resolvers, 4-1
MacOS, D-3
multiplexed scanning, D-3
steps, 5-26
overview, 1-1
power-up state, D-3
removing (figure), C-2
removing from SCXI chassis, C-1
scaling LVDT and RVDT data, 4-8
self-test, troubleshooting, D-1
specifications, A-1
theory of operation, 4-4
using, 2-1
virtual channel string, 5-26
self-test verification, troubleshooting, 1-6, D-1
signal connections
front signal connector, 2-5
pin assignments (table), 2-6
LVDTs and RVDTs, 2-1
rear signal connector, 2-5
resolvers, 2-4
synchronizing channels, 2-3
software, using for multiplexed scanning, 5-24
specifications
absolute accuracy, A-4
electromagnetic compatibility, A-6
environmental, A-6
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general specifications, A-1
input range, gain, and required DAQ
device limits (table), A-1
maximum working voltage, A-5
physical, A-5
power requirements, A-4
safety, A-6
synchronization
external, 3-2, 4-4
multiple channel synchronization, 2-3

T

theory of operation, 4-4
troubleshooting, self-test verification, 1-6, D-1

v

verifying and self-testing the configuration,
troubleshooting, 1-6
virtual channel string, 5-24
LabVIEW, 5-26
voltage, maximum working, A-5

W

wire mode, setting, 3-2
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